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1Getting Started with 
PREMIER+™ 2 Create & Font Create
Welcome to PREMIER+™ 2 Create, the software that helps you create wonderful 
embroideries. Turn your favorite pictures into embroideries and see them on the screen 
exactly as you will sew them. Work with images from your favorite social media sites, 
scanner or digital camera, and use clipart or create your own pictures with the built-in 
drawing or painting tools.

Use PREMIER+™ 2 Font Create to create beautiful fonts and SuperDesigns for PREMIER+™ 2 
Embroidery. Create fonts using most TrueType®/OpenType® computer fonts, or digitize 
characters and SuperDesigns over scanned or clipart pictures.

ExpressDesign Wizard
PREMIER+™ 2 Create includes the ExpressDesign Wizard. Use it to automatically create 
designs from a picture, load pictures for new designs, open an existing design or start a 
new design with no picture. The ExpressDesign Wizard can create designs to fit a hoop, fit 
a size you specify or fit an area you select. Choose from three design types:

Creating Pictures
Create your pictures using the drawing or painting tools and MiniPics. Filter and improve 
your pictures, or add interesting effects. Save drawings or pictures or send them to the 
ExpressDesign Wizard. Convert vector drawings to objects automatically.

Quick Create and Shape Features
The Quick Create features QuickStitch™ and QuickTrace are alternatives to the 
ExpressDesign Wizard for creating sections of your design.

With QuickStitch™, click in an area and stitches are produced automatically in an instant! 
Choose to embellish your designs with motifs, running, double or triple outline stitches, 
motif lines, borders with any combination of straight lines and curves or appliqué, 
creating a fill area, line, or satin area.

Express Embroidery creates 
a standard embroidery 
design using satin, fill areas 
and outlining.

Express Trace traces outlines 
in a picture to create, for 
example, redwork, quilt 
stencils and so on.

Express Border creates satin border, 
appliqué, running stitch, triple 
stitch or motifs around the edges of 
solid color areas in the picture.
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The QuickTrace feature automatically creates stitches that follow a continuous line. Create 
a Double trace , Quadruple trace , Satin line  or Motif line  trace.

Also in Quick Create, create one of 75 shapes automatically as a fill area or line.

Freehand and Precise Create Features
The Freehand Create and Precise Create features allow you to work with your stitches in 
detail. Draw an outline, place points, or draw Bezier curves around an area of the picture, 
and the stitches appear with your choice of pattern. Include a satin stitch or other line 
border if you wish, and set the angle of stitching to any degree. Insert holes where you 
choose.

Choose Satin Column  (including over 250 patterns, and multigradient and multicolor 
gradient options for color blending), Satin Areas  or constant width Satin Lines  and 
emboss them with needle point highlights. Create Feathered Satin  and texture either 
or both edges of a satin stitch for special embroidery effects on fur or flowers. Create 
columns of Tapered Motifs .

Make cutwork designs easily with Richelieu Bars  and Running Stitch with cutwork 
needle lines. Use other features such as Double Zigzag stitch , Crosshatch Fill  and 
Curved Crosshatch Fill  to create free-standing lace.

Add individual stitches in straight or curved lines of Running, Double and Triple Stitch 
from 1 to 12mm.

Design Choices
Adjust designs using easy editing features: Navigate around the design with the Filmstrip, 
change easily between lines, fills, stitch types and patterns and so much more. Appliqué 
options offer four stitchout methods including export for automatic needles or fabric 
cutters.

Fill patterns and techniques are amazing – choose from over 250 fill patterns  or make 
your own. Emboss patterned fill or satin areas, or columns, with personal highlights. Set 
the start and end of fill areas if desired and use up to 500 holes. Use single gradient density 
to produce beautiful shading effects, and multicolor gradient density to produce gradual 
shimmering color changes.

Beautiful fill types include Radial , Spiral , Shape  Fill with 75 shape options and 
motif options, QuiltStipple , Contour , Crosshatch  Fill. MultiWave  Fill creates 
flowing waves of stitching with motif options. Echo  Fill repeats any area with shadow 
effects. Curved Crosshatch Fill  provides wonderful intersecting patterns for three-
dimensional effects.

Choose from machine stitch Motifs or Universal Motifs such as the beautiful Hand Stitches 
for Motif  Fill areas. Even create your own motifs!

Insert existing designs, embroideries, lettering or SuperDesigns into your project. 
Grouping features allow you to keep smaller parts of your design together.
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Finding Information

User’s Guide and Reference Guide
The User’s Guide and Reference Guide show how to start the module and provide a quick 
tour of the main screen. This is followed by information on key features, together with 
short ’How-To’ examples, which will help you learn how to use the module. The Reference 
Guide additionally contains full reference information. The Reference Guide is supplied in 
PDF format , ready for printing.

To find all the Reference and Sample Guides for your PREMIER+™ 2 Embroidery System 
software, in Windows® 10 and 8 select the Desktop tile on the start screen. Then in 
Windows® 10, 8 or 7, double-click the PREMIER+™ 2 Embroidery System shortcut on your 
desktop, and double-click Reference Guides or Sample Guides. Select the desired guide.

Sample Files
Samples are included that are shown in the ’How-To’ examples and tutorials. The sample 
files will be installed to subfolders of Documents\Premier+2\Samples\Create or the folder 
of your choice.

Starting PREMIER+™ 2 Create and PREMIER+™ 2 Font Create
 To open PREMIER+™ 2 Create, in PREMIER+™ 2 Embroidery, click the PREMIER+™ 2 Create 

icon  on the QuickLink toolbar. PREMIER+™ 2 Create will start.
 To open PREMIER+™ 2 Font Create, in PREMIER+™ 2 Embroidery, click Accessories  on 

the QuickLink toolbar, then click PREMIER+™ 2 Font Create .

Parts of the Software Window
Title Bar
The title bar at the top of the window is highlighted if PREMIER+™ 2 Create is active. The 
Quick Access toolbar gives icons for the following frequently used features: Insert, Save, 
Save As, Export, Print, Change Hoop, Undo, Redo, Life View and Design Player. 

If more than one instance of PREMIER+™ 2 Create is open, each open window will show 
the name of the embroidery file.

Ribbon Bar
There are 9 tabs on the ribbon: File, Home, Quick Create, Freehand Create, Precise Create, 
Edit, Draw or Paint, View and Help.

Either the Draw or Paint tab is available for each design. The options on the File menu are different when 
you use the Draw or Paint window. Only the Paint tab is available in PREMIER+™ 2 Font Create. 
An alternative way to access ribbon options is to press the Alt key, then the highlighted letter of the tab, 
followed by the highlighted letter of the tab item, e.g. Alt, H, M, S. Some functions are available by pressing 
the Ctrl key and another key at the same time. These shortcuts are shown in the tooltip for the function.
Use the Home tab to select, copy, Group, move, resize and rotate parts of a design; to add, 
change and remove points in object outlines; to insert designs, embroideries, letters, 
ExpressDesigns and SuperDesigns; to change the hoop, and to display embroideries with 
Life View and Design Player.
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Use the Quick Create tab QuickStitch™ and QuickTrace features to create fills, lines and 
satin areas automatically by clicking color areas in the picture. Use the Shape features to 
create fill or line shapes instantly in the design area, ready for resizing.

Use the Freehand Create tab to draw the outlines for lines, satin and fill areas with a pen on 
a graphics tablet, or by dragging with the mouse. Draw to add holes, emboss lines and 
MultiWave lines to fill areas. Place points to create Satin Columns, Feathered Satin, 
Richelieu Bars and Tapered Motif columns.

Use the Precise Create tab to place a series of points or Bezier curves that define the 
outline of lines, fills and satin areas. Place points or Bezier curves to add holes to fill areas, 
and to create Satin Columns, Feathered Satin, Richelieu Bars and Tapered Motif columns.  
Place points to add emboss lines and MultiWave lines to fill areas.

Cut, copy, paste or delete selected objects

Use a selection tool to select objects

Group and Ungroup objects

Resize and rotate the selected block

Move, add, delete & convert the points for an object

Insert a design
View the design as it will be stitched out

Choose a hoop

Add Color changes

Select stitch types and appliqué

Create a fill area or line automatically
Select a Shape and create it as a line or fill area

Cut a hole in a fill area

Draw a wave line in a MultiWave Fill area
Emboss a line on a fill area or column

Trace a picture as a line of stitches

Create a Satin Area

Set the properties for the stitch types

Add Color changes, Single & Alignment stitches, and Stops
Select stitch types and appliqué Draw a fill area or line

Cut a hole in a fill area
Draw a wave line in a MultiWave Fill areaEmboss a line on a fill area or column

Place points for a Column

Draw a Satin Area

Set the properties for the stitch types

Add Color changes, Single & Alignment stitches, and Stops
Select stitch types and appliqué Create a fill area or line

Cut a hole in a fill area
Draw a wave line in a MultiWave Fill areaEmboss a line on a fill area or column

Create a Column

Create a Satin Area

Set the properties for the stitch types

Use Bezier Mode
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Use the Draw tab to load or create a vector drawing for your design. Modify a drawing as 
desired, or make your own drawing. Alternatively, load a raster image to use as a 
background. Create motifs, or stamps for PREMIER+™ 2 Modify, too.

Use the Paint tab to load, scan or create a background picture for your design in the Paint 
window. Modify a picture as desired, or draw your own picture.

Use the View tab to adjust the Grid, measure the design, show and fade the background 
picture, show the FilmStrip, and change the view mode or hoop.

Windows
PREMIER+™ 2 Create uses three windows: Design, Draw and Paint. Switch between 
windows by clicking the tabs at the top of the window or with Ctrl + Tab. All the tabs of the 
ribbon bar use the Design Window except for the Draw or Paint tab.

Design Window

Use the Design window to add new areas, lines and columns of stitching, as well as 
commands, to your design, and to change the properties of stitching.

Create stitch areas and lines using the QuickStitch™, QuickTrace, Freehand and Precise 
Create features on the ribbon bar tabs. Choose colors, and select a line or fill type for stitch 
lines or borders such as single, running, double, double zigzag, triple, satin or motif lines; 
for fills such as pattern fill, motif fill, shape fill and crosshatch fill; for Richelieu bars and 
tapered motifs, and for satin columns and areas. The Design window shows a 3D, 2D or 
Object outline representation of the stitches in the design. To see the stitches with no 
objects selected, use Life View  or Design Player .

The points are shown on the work area for the currently selected object. Fill areas, satin 
areas and columns have markers that show where they start  and end . Some types 

Title Bar Ribbon BarRibbon Bar Tabs

Work Area Status BarFilmStrip Design Panel

Quick Access Toolbar
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of fill areas also have an origin  that affects the position of the stitch effects. There are 
also markers for Color Changes , Stop Commands  and Alignment Stitches .

To the left of the Design window work area is the FilmStrip, and to the right of the work 
area is the Design Panel. Use the Create tabs to create stitches, and the Edit tab, the 
FilmStrip and the context (right-click) menu to edit your design.

The Design Panel contains the color worksheet, notes and settings for the design, and the 
Clipboard and Overview window.

The Font Tab and PREMIER+™ 2 Font Create

The Font Tab in the PREMIER+™ 2 Font Create Design Panel contains functions for 
opening, saving, exporting, and editing a font or SuperDesign set, and for viewing and 
positioning the font grid, guidelines and background characters. Choose a background 
font and a character set, then select a character or SuperDesign for editing. Set the Nearest 
Point positions for fonts, and load and save thumbnail pictures for SuperDesigns. Preview 
the font or SuperDesign set at varying sizes.

 To create a font or SuperDesign set, start PREMIER+™ 2 Font Create, and in the Create or 
Edit Font dialog box select Font, or SuperDesign set, and either edit an existing font or set, 
or set the Name, type and size for your new font or SuperDesign set. 

 Use the Font Tab and the shared PREMIER+™ 2 Create and PREMIER+™ 2 Font Create 
functions to add characters or designs to your font or SuperDesign set.

To use PREMIER+™ 2 Font Create, you will need a good working knowledge of the stitch types, concepts 
and tools used in PREMIER+™ 2 Create.
For more information on creating fonts and SuperDesign sets, see the PREMIER+™ 2 Font Create Reference 
Guide.

Open or save the font or SuperDesign set
Set the recommended size
Change the font or SuperDesign properties

Use a Windows system font as a background for each character
Adjust the Font Grid & Guidelines, and place Navigation objects
Update the thumbnails when the font or set is saved
Select a Character Set

View other pages of characters within the font

Select a character to edit (digitized characters are green)

Open or save a thumbnail picture for the selected SuperDesign
Select the Nearest Point position for the current character

Adjust the size for previewing the font or SuperDesign set

Copy multiple characters, e.g. upper to lower case
Insert extra points on straight or curved lines
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Paint Window

Use the Paint window to load, scan or create a background picture for your design. Load 
pictures from many social media sites. Modify a picture, or draw your own picture.

Draw Window

Use the Draw window to load or create a vector drawing for your design. Modify a drawing 
as desired, make your own drawing to create a motif or stamp, or load a raster image to 
use as a background.

Title BarRibbon Bar Tabs Ribbon Bar

Work Area

Control Panel

Status Bar

Quick Access Toolbar

Quick Access Toolbar Ribbon Bar Tabs Ribbon BarTitle Bar

Work Area

Control Panel

FilmStrip Status Bar
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PREMIER+™ 2 Create Terms and Conventions
On-screen Pointers
The pointer is most commonly shown as an arrow  on the screen.

If it is positioned over a text box it changes to an I-bar  and you can type, such as the Edit 
Notes dialog box in the Design Panel.

If Zoom To Rectangle  is chosen, the Zoom In pointer  appears. If the Pan feature is 
used to move around the screen, the Pan cursor  appears. If Get Length  is chosen the 
Measure pointer  appears.

In the ExpressDesign Wizard Rotate and Crop Picture page, the pointer becomes a double-
headed arrow  when you move the crop lines or a four-headed arrow  when you 
move the crop area. Also, for an Express Embroidery, the pointer becomes an 
eyedropper  to pick colors from a picture for thread colors or pick a background color.

In the Freehand Create tab, if the Freehand Create functions are used the pointer becomes 
a pen . 

In the Precise Create tab, if the Precise Create functions are chosen the pointer becomes a 
circle , and in Bezier Mode when lines are drawn the pointer becomes a Bezier Mode 
pointer . In Bezier Mode, when points are coverted to Symmetric the pointer becomes 
the Convert Points to Symmetric pointer , when points are coverted to Smooth the 
pointer becomes the Convert Points to Smooth pointer , and when  points are coverted 
to Corner points the pointer becomes the Convert Points to  to Corner pointer .

When node points on Point Lines or Bezier Lines are adjusted, or the Fabric handle  is 
used to adjust a fabric,  the pointer becomes a small cross  (a Move pointer).

If Insert ExpressDesign  is chosen, the Draw Rectangle pointer  appears.

When a Pick Color  function is selected, the eyedropper pointer  appears.

The Box Select , Freehand Select  or Freehand Point Select pointer  appears when 
the associated Select function is chosen. The Ellipse Select  pointer or Magic Wand  
pointer appears when these functions are chosen in the Paint window.

The diagonal double-headed arrow  pointer appears when the mouse pointer is over a 
square corner handle . The horizontal double-headed arrow  pointer appears when 
the mouse pointer is over the Flip Horizontal handle . The vertical double-headed 
arrow  pointer appears when the mouse pointer is over the Flip Vertical handle . The 
pointer becomes a four-headed arrow  (a move pointer) when it is over a selection box

In the Paint window the pointer changes to the paint bucket  when Flood Fill  is 
selected, the brush pointer  when Paintbrush  is selected, and the calligraphy 
pointer  when Calligraphy  is selected.

The Create Cursor  is not a mouse pointer, but is a marker that shows the position 
where the next object will be added if it is at the end of the design. These cursors only 
appear when at least one object has been digitized on the current character or 
SuperDesign, and one of the Create tools is selected.
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 When objects will be added at the end of the design, the cursor is pink .
 When objects are to be inserted (i.e. the selected object is not the last object in the 

design), the marker showing the final point of the selected object is orange .

 When objects are to be inserted, a blue marker  shows the position of the first point in 
the next object in the design.

Picture Files
PREMIER+™ 2 Create can load any of the following picture file formats: Windows or OS2 
Bitmap (.bmp), JPEG-JFIF Compliant (.jpg, .jif, .jpeg), Portable Network Graphics (.png), 
Tagged Image File Format uncompressed (.tiff, .tif ), 4QB (.4qb), QuiltSewClever / Quilt 
Artist / Shirley Stitcher QCC (*.qcc), Windows Meta File (.wmf), Windows Enhanced Meta 
File (.emf ), CorelDraw (.cdr version 7-13, .cmx), Encapsulated PostScript File (*.eps), 
Scalable Vector Graphics (.svg), HPGL (*.hp and *.plt), PC Quilter (*.txt), Statler Stitcher 
(*.qli), AutoCAD (*.dxf ), CompuQuilter (*.cmd and *.cqp), Handi Quilter (*.hqf ), 
IntelliQuilter (*.iqp) and Windows Icon (.ico). In addition, the ExpressDesign Wizard can 
load .4dq files produced by the Grace Company PatternCAD module.

PREMIER+™ 2 Create can save a picture in any of the following picture file formats: 
Windows or OS2 Bitmap (.bmp), JPEG Low Quality (.jpg), JPEG High Quality (.jpg), Tagged 
Image File Format uncompressed (.tif ) and Portable Network Graphics (.png). A drawing 
may be saved in 4QB (.4qb) format and used to create a motif, or a stitch for certain sewing 
machines, or a stamp for PREMIER+™ 2 Modify. The picture or drawing is also saved as part 
of the design outline (.edo) file.

PREMIER+™ 2 Create can upload pictures and videos of embroidery designs from Design 
Player and Life View to Facebook® , Flickr® , Twitter®  and YouTube® .

Design Files
PREMIER+™ 2 Create loads and stores embroidery designs (design outlines) in files with 
the extension .edo. When a design is saved, the picture is saved with it.

PREMIER+™ 2 Create can insert a .can outline file (from 5D™ Design Creator), without the picture.

Embroidery File Formats
PREMIER+™ 2 Create can insert any of the following embroidery file formats: Bernina (.art 
version 1, 2, 3), Brother/Babylock/Bernina PEC (.pec), Brother/Babylock/Bernina PES (.pes 
version 2 - 10), Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vp4, .vp3 and .vip), 
Husqvarna (.hus, .shv and .dhv), Janome (.jef and .sew), Melco (.exp), Pfaff (.pcs), Tajima 
(.dst) and Toyota (.10*).

PREMIER+™ 2 Create exports the following embroidery formats: Husqvarna Viking / Pfaff 
(.vp4 and .vp3), Brother/Babylock/Bernina PEC (.pec), Brother/Babylock/Bernina PES (.pes 
version 2 - 10), Compucon/Singer PSW (.xxx), Husqvarna Viking / Pfaff (.vip), Husqvarna 
(.hus, .shv), Janome (.jef, .sew), Melco (.exp), Pfaff (.pcs), Tajima (.dst) and Toyota (.10*).

The preferred file format for exporting embroideries is .vp4 format as this will preserve the separate parts of 
multipart designs. It also preserves hoop, background and appliqué information, thread colors and notes.
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2The Design Creation Process
PREMIER+™ 2 Create is used to create designs for embroideries.

You can use a design made in PREMIER+™ 2 Create to create an embroidery at any time, and can use the 
same design to create otherwise identical embroideries for different hoops.
There is no need to directly manipulate individual stitches.

Start with a picture.

View and create objects in the design in 
the Create tabs.

Use the ExpressDesign Wizard to create a 
design.

View and edit objects as 3D, 2D or outlines.

Add areas, for example tapered motifs or 
Richelieu Bars, or insert new elements.

Edit areas, for example to specialty fills.
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There are three ways to make a new design:

 Create a design automatically with the ExpressDesign Wizard. The wizard requires a 
picture to convert to a design.

 Load or draw a picture, then make a design by following the picture automatically with 
the QuickStitch™ and QuickTrace features in the Quick Create tab. Additional design 
elements can be added using the Freehand Create (drawing outlines with a mouse or on a 
tablet) or Precise Create (placing points) functions, as well as Shapes and columns.

 Create a free-form design with no background picture, mainly using the Freehand Create, 
Precise Create, column, Shape and command features.

Use File, New , or File, New Window  to start a new design with the ExpressDesign 
Wizard. In the wizard you can create a new design automatically, load a picture for a new 
design, load an existing design or start a new design with no picture. On the main screen, 
you can Insert  a design, or in the File menu Open  a design, Open Recent or Load a 
Design with Drag and Drop. Use Insert to load a .can design outline file. 

Use a Picture as a Background
When starting from a blank design, you may simply choose a hoop, and start creating your 
design with the Freehand, Precise, Command and Column features. However, it is more 
common to follow a picture when creating a design. Create your own picture using the 
functions in the Draw and Paint windows. Open an existing drawing with Open 
Drawing  or Insert Drawing . Open an existing painting with Open Picture , Insert 
Picture , or use From Scanner or Camera  to load a picture from a scanner or digital 
camera.

To open an embroidery as a design, use File, New  or File, New Window  to start a design with no 

picture, and Insert Embroidery  to convert an embroidery to a design.

After creating or editing your picture as desired, it is recommended to save it. Then either 
send the picture to the ExpressDesign Wizard  from the File menu, or go to the Design 
window and start creating your design with QuickStitch™, Freehand and Precise features.

Insert existing designs, embroideries, lettering or SuperDesigns into your project. Save 
finished designs with Save  or Save As , then create an embroidery with Export .

The ExpressDesign Wizard
Use the ExpressDesign Wizard to create new designs automatically from pictures. There 
are three design types that can be created in the ExpressDesign Wizard: Express 
Embroidery, Express Trace and Express Border.

From a picture... ... to a complete design and embroidery.
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There are three ways to start the ExpressDesign Wizard to create a new design.

 Use File, New , or File, New Window , to clear the PREMIER+™ 2 Create screen and 
create a new design.

 In the Draw or Paint window, use File, Send To Wizard  to send the current picture to the 
ExpressDesign Wizard.

 Use Insert ExpressDesign  to create a new design in the ExpressDesign Wizard that fits 
proportionally in a rectangle you draw, or to fit the current hoop.

Additionally, when started with File, New , or File, New Window , the ExpressDesign 
Wizard can be used to load a picture for a new design, load an existing design or start a 
new design without a picture.

Using Existing Designs
Any design can be used as the starting point for a new design. This includes a design you 
may have just created with the ExpressDesign Wizard, which you can modify and 
embellish as desired.

For example, a design might be changed dramatically by adding or removing a border, 
changing the fill type, or changing the pattern in a fill area. Also, for a design that you wish 
to use at a different size, you could change line types from satin to running, triple or motif 
stitch. Any line or area can be changed to appliqué.

Use existing designs, and designs created in the ExpressDesign Wizard, to create new 
designs and design collages.

What Makes a Design
A design in PREMIER+™ 2 Create is composed of areas, lines, columns and commands.

 Fill Areas and Lines
The area features are used to create many different types of filled or stitch areas in which 
fills, for example Pattern fill , (and holes) can be placed. Also create Running stitch , 

Double stitch , Double zigzag , Triple stitch , Satin  or Motif lines . Lines 
may be created alone or to border an area.
Lines are defined by points, which can be moved to change the shape of the line, or an area it encloses.

 Columns
The column features are used to create Satin Column , Feathered Satin , Richelieu 

Bars  and Tapered Motifs .
 Commands

Commands are instructions such as a change of thread Color , an alignment stitch , 

or a Stop .

The term ’object’ is used to refer to any or all of these.
When an embroidery is created from a design, each line or area is converted to stitches, 
and the stitch order is controlled by the order of the objects in the design.

You can see the order of objects in the FilmStrip.
There are several ways to add objects to a design:
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• Use the ExpressDesign Wizard to create a whole design, with all the necessary lines, 
areas and commands. Edit or add to the design as desired.

• Use the Create tabs to add new objects to a design which can be based on a picture 
shown in the background, and to change the properties of those objects. 

• Use the Home tab to insert complete design elements, embroideries , font 

characters , SuperDesigns , or to copy and paste selections.

Pictures
Most designs are based on pictures, either by using the ExpressDesign Wizard or by using 
the functions of the Create tabs to follow a picture. The Draw and Paint windows of 
PREMIER+™ 2 Create can be used to edit existing pictures and create new pictures.

Changing a Picture During Design Creation
You can change a picture during the design process. For example, you may wish to break 
up or merge color areas so they produce the desired result with QuickStitch™ or 
QuickTrace. You can also draw new features, insert MiniPics, move, copy and resize 
selected areas and so on.

Pictures for the ExpressDesign Wizard
If you wish to modify a picture before using it in the ExpressDesign Wizard, you will need 
to load it directly into the Draw or Paint window. Click File, New , or File, New 
Window , and choose the appropriate option, then load your picture. You can also load 
a picture in an open Draw or Paint window.

Only vector images may be adjusted in the Draw window. Raster images may be used as a background in 
the Draw window, or edited in the Paint window.
Use the Draw or Paint window to adjust your picture, save it with a new name, then use 
the new picture in the ExpressDesign Wizard by using File, Send To Wizard . 

When vector pictures are sent through the wizard  from the Draw window using the 
’Retain individual object layers’ option, the order of embroidery matches the Draw 
window FilmStrip order.

Lines are converted to running (0.5 or 1mm), triple (2mm), or satin (3mm or above) depending on their 
width. Filled areas are converted to pattern fill.
It is recommended to keep your original picture in case you wish to adjust it again with different options.

Enhancing Details
The significance of details in a picture is dependant on the overall size of the picture after 
it is cropped, so small details are more significant in a small picture. Also, small details are 
enlarged as the size of the created design increases, so extra detail may appear if you 
simply make a larger design with the same picture.

However, very small details in a picture may sometimes be ignored, as they may not have 
enough significance to be created as an area or outline in the embroidery. To enhance 
details, select Picture Options in the ExpressDesign Wizard, ensure Expand Pixel-Thin Lines 
is selected and set the Area Sensitivity to High. If this does not work, either enlarge the 
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details in the Paint window, or, for outline details, connect small details together so they 
are created as a single outline.

Pictures for QuickStitch™ and Freehand
The best size for a background picture for PREMIER+™ 2 Create is approximately 
1500x1500 pixels (or greater).

If you only wish to use a small part of the picture that has been loaded, use Box Select to 
select the desired area and then Crop to remove the rest of the picture.

The QuickStitch™ features use defined color areas to place areas and lines. Use the Color 
Tolerance function to merge different color shades to change the size of this area.

Pictures as Backgrounds
Use Embroidery to Enhance a Picture
Using PREMIER+™ 2 Create with pictures allows you to choose different stitches to 
highlight the desired features in a picture printed on fabric. For example, outline a shape 
in complementary or contrasting thread colors, use metallic threads to add sparkle, create 
three-dimensional effects with shading and add embellishments with motifs.

To help see stitches against a picture, use the Background mode slider bar in the View tab 
to change the picture display between On , Fade  and Off .

Use Alignment Stitches  to align the embroidery on a picture that you have printed on 
fabric.

Printing Pictures on Fabric
It is recommended to test the printouts of pictures onto the final fabric, as the colors may 
not be reproduced onto fabric in the same way as on the screen.

The picture can be printed with the colors faded by 50%. This is an effective technique for 
making the embroidery stand out over the picture.

Create Petals with the ExpressDesign Wizard
1 Click File, New , or File, New Window  and the Choose Design Type page of the ExpressDesign 

Wizard will appear.
2 Leave Create Express Embroidery selected and click Next. The Choose Picture page will appear.
3 Click Load a Picture  and the viewer will appear.
4 In the Picture Viewer, browse to Documents\Premier+2\Samples\Create\Pics. The pictures in the 

folder will be shown.
If you position the arrow pointer over a thumbnail without clicking, the name of the picture will be shown. 
The picture is called 'Petals.wmf'. Alternatively, select an icon display that shows the names.

5 Click the 'Petals.wmf' thumbnail, and then click OK. The picture is loaded onto the Choose Picture 
page, with its name shown below the preview area.

6 Click Next and the Rotate and Crop Picture page will appear.
Notice that the picture has no background color yet. This is because pictures in Windows Meta File (wmf) 
format can have an empty background. However, after the picture is cropped, white is used by the 
ExpressDesign Wizard to replace empty areas. 
When white thread is not desired in the background of an Express Embroidery, it may be removed on the 
Choose Thread Colors page. The white background is ignored by Express Trace and Express Border.
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7 No adjustment of the crop area is required, so click Next and the Design Size page will appear.
8 Select Fit Design To Hoop.
9 Click Change Hoop and the Hoop 

Selection dialog box appears.
10 Ensure that Enter Hoop size is not 

selected (checked).
11 Select the Universal Hoop Group, then 

set Hoop Size to 240mm x 150mm - 
Universal Large Hoop 2. Ensure the 
Orientation is Rotated, and click OK. 
The chosen hoop is previewed.

12 Click Next and the Choose Thread 
Colors page will appear. Notice that all 
5 of the 5 possible colors have been 
automatically picked.

13 If the thread range in the Change All 
To box is not set to Robison-Anton 
Rayon 40, click the drop-down arrow 
at the end and select Robison-Anton Rayon 40.

14 Under Background Color, the large white square shows that white is the detected background color. 
The white background is not required, so ensure Automatically Remove Background Color is selected. 
A check pattern in the Thread Color Preview shows where there will be no stitches.

15 Click Next. Stitches will be created, 
then the Fabric and Stitch Type 
Options page will appear.

16 Ensure that the Fabric is set to Woven.
Notice that the design is previewed on 
the selected fabric. This may differ from 
the fabric selected in PREMIER+™ 2 
Configure, but the background color 
chosen in PREMIER+™ 2 Configure is 
always used.

17 Ensure the Design Underlay option is 
turned off and leave the Preferred 
Stitch Type slider all the way to the 
left.
Some of the petals will be changed to 
lightly stitched fill patterns that would 
reveal the underlay if it is left on.

18 Click Finish and the final design and its picture are shown on the work area.
19 Click the Edit button  next to the Notes box on the Design Panel.
20 In the Notes dialog box enter 'Floral'.
21 Use the quick keyword selector to add the keywords ’Flowers and Gardens’. Then click OK.

Notes entered for the design will also be saved in the embroidery when it is exported in .vp4 format. Notes 
are used to search for embroideries by key words in Windows® Explorer.

22 Click Save  and browse to the folder Documents\Premier+2\My Designs.
23 Change the File name to 'PetalsBasicFill' and click Save.

This saves your project as a design file in .edo format.

Change a Fill Area to a Leaf Pattern
1 Click File, New , or File, New Window , and in the Choose Design Type page of the 

ExpressDesign Wizard select Load Existing Design, then click Next. In the Open Existing design page, 
click Load a Design , browse to the folder Documents\Premier+2\Samples\Create\Edo, and load 
the file 'PetalsBasicFill'.
Alternatively, use the petals design that you created in “Create Petals with the ExpressDesign Wizard” on 
page 14.
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2 Click File, Preferences  and ensure that Color Tolerance is selected (checked), and that Tie Off 
Before and After Trims is selected.

3 Click the View tab, and set the Grid size to 5mm.
4 In the color worksheet on the Design Panel, click the check box for the fourth 

color (slate blue) to hide objects, mainly satin borders, using that thread color. 
This will make it easier to select the fill areas.
When you pause the arrow pointer over a color in the worksheet, a popup 
description of the thread appears.

5 Click the Home tab.
6 Ensure that Edit Points  is selected.
7 Click inside the left petal near the 

edge. The points defining the shape of 
the fill area will appear. It will be 
shown as a Pattern Fill on the status 
bar and in the FilmStrip.
If the Status Bar says Box Select, this is 
selected instead of Edit Points . Click 
Edit Points and look again.

8 Right-click on the work area and the 
Fill Area and Line dialog box will 
appear showing the properties for 
Pattern Fill.
The Fill Area and Line dialog box 
enables you to change the fill and line 
types in your design, and set the 
properties for the lines and fills.

9 Click the down arrow below the fill 
sample in the Pattern area.

10 The fill Category is currently set to 
Standard 1. Scroll up the fill gallery to 
the 'Plants & Flowers 1' Category.

11 Place the pointer over the pattern 
sample in row two, column two. The 
pattern number is 164.
Patterns may also be selected directly by entering the desired pattern number in the Pattern box.

12 Click to select pattern 164.
13 Check that Density is set to 2, as desired.
14 Change the angle to 45. Click Apply to see the new pattern 

in the left petal, then click OK.
Even if you click Cancel, Apply has changed the stitches. 
Therefore, to return to the original pattern you would need to 
click Undo .
For further exercises using PREMIER+™ 2 Create, see the 
PREMIER+™ 2 Create Reference Guide.
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3Viewing Designs
Use the View tab to set how you view the design, background picture, and hoop.

View Mode
Use View Mode to switch between 3D , 2D , and Object  representation of 
stitches. 3D View  shows how the embroidery will be stitched out with three-
dimensional shading. 2D View  shows the individual stitches with no shading. Stitches 
using multicolor threads are drawn using only the first color. Object View  shows the 
outline of the objects in the design.

Use Show Grid  to turn the background grid on and off. The grid may be used to help 
align stitch objects and control points. Adjust the grid Size between 1 and 50mm.

The grid size set in the Design window also affects the Paint and Draw windows.
Use the Background slider bar to show, fade or hide the background picture.

3D View 2D View Object View 

Use Background On  to show 
the picture in the background.

Use Fade  to fade the colors by 
50%.

Use Background Off  to hide the 
picture. 

Show and adjust the grid Show and fade the background

Change the view mode

Choose a different hoop

View the Design Panel & FilmStripMeasure an object or design
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Design Panel
Use the Design Panel to view the design information, to view and change colors, to view 
and change the Notes and Settings, and to view the Clipboard and Overview window.

Colors
Use Color Change  and Pick Color  on the Create tabs, or Insert Color Change  in 
the FilmStrip to select a new thread color for the stitch objects you are about to add to the 
design. The first Color Change is initially set to medium blue. A Color Change command is 
shown by a small blue circle with a C .

To change an existing color, double-click the desired color in the color worksheet on the 
Design Panel, or select the color in the worksheet and click Change Color . 
Alternatively, right-click the color in the FilmStrip and select Properties. The Color 
Selection dialog box opens.

To delete a color change, select the Color Change in the FilmStrip or on the work area, 
then click the Delete icon , use the Delete key, or right-click in the FilmStrip and select 
Delete. The first Color Change in a design may not be deleted.

To insert a color, select the object after which the color change is desired, and click Color 
Change  on one of the Create tabs, or right-click in the FilmStrip and select Insert Color 
Change from the context menu. Alternatively, select Pick Color  and choose a color 
from the background picture.

Select a color from the Color Selection box that appears. You may choose any thread 
shade from the available thread manufacturers' palettes (for instance, Sulky Rayon 40 or 
Robison-Anton Cotton 50) or a thread you have added to MyThreads. Select colors by 
visual selection or by typing in a shade number. Alternatively you can choose a ’Quick 

Check the design information

View and change the threads and effects for the design

Change a thread color
Show and hide secondary thread colors
Select the Notes or Settings information

View the contents of the Clipboard

Dual thread effect

Edit the Notes or Settings information
View the current window position in the work area

Puffy foam effect

Secondary thread colors for fills with borders, or color gradients
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Color’ Theme and then select one of the 32 Quick Colors. Optionally, add a thread or 
needle effect to the selected thread. Once the desired color is selected, click OK.

Use the color worksheet in 
the Design Panel, and the 
Hide Object Types filter 
buttons in the Edit tab to 
show and hide the desired 
blocks of colors and object 
types in the design. You can 
also use the Draw Range 
slider bars on the Edit tab 
and the FilmStrip to change 
the view of the design.

Extra design property colors for some objects are set in the properties dialog for that 
object, for example multigradient fills and the border for a fill area. They then appear as 
secondary colors in the color worksheet, and can be adjusted from there.

A multicolor gradient fill or satin column will show a hatched pattern in the FilmStrip. To 
view these colors in the worksheet, ensure that Design Property Colors  below the 
color worksheet in the Design Panel on the right of the Design window is selected.

Pattern Fill with a border The FilmStrip and worksheet 
show both colors

Set a separate border color in the Line tab 
of the Properties dialog

Multigradient Pattern Fill with a 
border

The FilmStrip and worksheet 
show all colors

Set the colors for the multigradient fill in 
the Properties dialog

Pause over a thread color
to see its name

Click a color block to select it

Use the color worksheet to

Change the selected color

display or hide a color

Thread effect symbol

Show or hide secondary colors

Secondary thread color
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FilmStrip
Use the FilmStrip to view the numbered sequence of objects, select an object, change the 
sequence of objects, select objects to display, delete objects, insert Color Changes and 
Stops, view the properties of the selected object and change the properties of objects 
globally or in a selection.

Thread Color Bar
The color bar shows the color of each object, together with an icon representing any 
thread effect, even when the Color Changes are hidden.

A fill area with a differently colored border will show two colors. A multicolor gradient fill or satin column 

will show a hatched pattern. To view these colors in the worksheet, ensure that Design Property Colors  
below the color worksheet in the Design Panel on the right of the Design window is selected.

Showing Groups in the FilmStrip
Groups are shown in the FilmStrip with an orange header. The Group header is a solid 
orange block when selected, and an orange outline when not selected. The objects within 
the group have a pale gray background in the FilmStrip, as opposed to the white 
background for objects that are not part of a group. When the header for a group is 
selected, all other items in the group are also selected, and are highlighted.

Use Display Group Contents  to switch between viewing the objects within Groups in 
the FilmStrip, and seeing only the Group heading rows in the FilmStrip.

View the object color in
the Thread Color Bar

The first object is a color or group

Objects are shown by their
shape or a marker

View the name of the object type

Scroll up and down the FilmStrip

Use the Layout Order buttons
to move objects in the FilmStrip Select the last visible object

No line between linked objects

Line between chains of linked objects 

Both fill and border colors are shown

Multicolor gradient fill area

Display group contents
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4Creating Design Elements
A design in PREMIER+™ 2 Create is composed of areas, lines, columns and commands 
(objects). After creating any fill or satin area, or column, emboss it by placing needle points 
to enhance the pattern.

Use lines as individual stitch lines or borders around an area or appliqué. 

Lines are defined by points, which can be moved to change the shape of the line, and any area it encloses. 
Choose a fill type (e.g. pattern fill, motif fill and so on), 
and a line type (e.g. satin line or running stitch) for 
each area, and add an appliqué fabric and placement 
stitches.

Set the Fill, Line and Appliqué buttons as desired by 
clicking to turn that area type on or off. Then choose 
line and fill types from the drop-down menu below the 
button. In the Options for Fill Area and Line, set the 
properties for your line and fill. After selecting the stitch types, use one of the Create 
functions to make a new stitch object.

Any line type can be converted to another line type after creation, and most area types can be directly 
changed to any other area type. 
Create columns by placing alternate points. Commands are instructions such as a change 
of thread color, an alignment stitch, or a stop.

Right-click to deselect a Create function when you have finished, or simply select another Create tool.
Areas and lines are created using the QuickStitch™, QuickTrace, Shape, Freehand Create 
and Precise Create features, or automatically with the ExpressDesign Wizard. Draw a line 
with the Freehand and Precise Create features, or follow a line in a picture with 
QuickStitch™, QuickTrace and the ExpressDesign Wizard.

Quick Create
Use the features of the Quick Create tab (QuickStitch™, QuickTrace and Shape) to create 
design areas automatically.

Creating with QuickStitch™, QuickTrace and Shape
Add Color changes

Select stitch types and appliqué

Create a fill area or line automatically
Select a Shape and create it as a line or fill area

Cut a hole in a fill area

Draw a wave line in a MultiWave Fill area
Emboss a line on a fill area or column

Trace a picture as a line of stitches

Create a Satin Area

Set the properties for the stitch types
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Click in a defined color area, or on a defined color line, in the background picture to create 
a QuickStitch™ or QuickTrace line or fill. The area outline is filled or the line is followed 
automatically. 

Use Color Tolerance to choose the color shades used when defining the area.

Using Color Tolerance with QuickStitch™ and QuickTrace
1 Select your stitch types, then select the desired QuickStitch™ or QuickTrace function, according to the 

type of stitches you want over the picture area you are about to select. 
2 Click in the desired area (for example, on the cat’s left side) of 

the picture for QuickStitch™ functions or on the desired line for 
QuickTrace functions.

3 If Color Tolerance is enabled, the Color Tolerance dialog box 
will appear. 
A red and cyan highlight shows the area of the picture that will 
be filled or traced. If you have chosen to detect holes, any holes 
in the area will be highlighted by green and yellow lines.

4 Use the slider to adjust the Color Tolerance value until the 
required part of the picture is selected.

5 Select the number of points to use for the outline; High will 
show more detail, while Low will be smoother.

6 Click OK to confirm the desired area is highlighted, and the line 
or area is created.

Color Tolerance Off
When Color Tolerance is not enabled, the stitch object(s) are created immediately, using 
only the color area that was selected. You can use the Color Tolerance option in 
Preferences  to turn Color Tolerance off, but this is only advisable if your picture has 
well defined flat color areas, and you have no need to select more than one color area to 
create new objects.

Creating Shapes
Use Shape  to place a selected shape in the work area. Then resize the shape, and set its 
properties. Select a fill and line to draw a fill area surrounded by a border, or select a line 
type only to draw a closed line with no fill.

Creating with Freehand Create and Precise Create
The Freehand and Precise Create tabs’ functions are used to make new stitch objects by 
creating object outlines directly on the design. The outlines may follow a background 
picture, if desired, but the Freehand and Precise Create functions do not require a picture. 
Most of the Freehand Create functions are used by drawing an outline, and most of the 
Precise Create functions are used by placing points or drawing Bezier lines to define an 
outline.

Freehand Create
When using the Freehand Create functions, lines and areas  are created by drawing 
outlines on the design with a pen on a graphics tablet, or by dragging with the mouse.

All of the Freehand Create tools work in the same way, except for Commands and Columns.
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Draw a Fill Area with Freehand Create
1 Select the stitch types.
2 In the Freehand Create tab, click Create Freehand Area or Line .
3 Draw one continuous line to create a line or area. 
4 Lift the pen or release the mouse button to complete the line or area. 
5 Repeat to draw as many new areas or lines as desired. 
6 Right-click to deselect the Freehand Create function when you have finished, or select another tool.

The Freehand Create functions provide a natural drawing experience and are generally recommended. 
When zoomed in, use the Scroll Bars to assist in drawing new objects.

Precise Create
With the Precise Create functions, lines and areas  are created by placing a series of 
points that define the outline. 

All of the Precise Create tools work in the same way, except for Commands and Columns.

Place Points with Precise Create
1 Select the stitch types.
2 In the Precise Create tab, click Create Precise Area or Line . The Freehand Point pointer  

appears.

To create an area with Bezier lines, use Bezier Mode .
3 Place each point with a single click.

Hold down the Ctrl key to place square points for the precise positioning of corners and straight lines.
4 Click and drag  to reposition an existing point.
5 Click Delete to remove the last placed point.
6 Right-click when the area is complete.
7 Repeat to place as many new areas or lines as desired. 
8 Right-click to deselect the Precise Create function when you have finished, or select another tool.

Bezier Mode
Use Bezier Mode  to draw shapes with finely graduated curves. Control 
the exact shape of the line using the black handles to either side of  the 
points you place.

Add Color changes, Single & Alignment stitches, and Stops
Select stitch types and appliqué Draw a fill area or line

Cut a hole in a fill area
Draw a wave line in a MultiWave Fill areaEmboss a line on a fill area or column

Place points for a Column

Draw a Satin Area

Set the properties for the stitch types

Add Color changes, Single & Alignment stitches, and Stops
Select stitch types and appliqué Create a fill area or line

Cut a hole in a fill area
Draw a wave line in a MultiWave Fill areaEmboss a line on a fill area or column

Create a Column

Create a Satin Area

Set the properties for the stitch types

Use Bezier Mode
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Click to place Corner points, or click and drag to place curve points with handles.

For information on Control Points and the other Bezier Line editing tools, see “Convert Points and Bezier 
Lines” on page 41. For information on Bezier Mode, see the PREMIER+™ 2 Create Reference Guide and Help.

Area Types
Any area can have a border, or no border. The border can be closed or open, and it can use 
any line type. Holes can be defined inside any fill area. Appliqué properties may be set for 
any area or line. Use Break Apart on the Edit tab to change an area with a border into 
separate fill area and line objects.

Any fill area can be converted into a Satin Area, however any holes in the fill area will be lost. (Any Border 
lines will be retained, including the borders of the holes.)

Pattern Fill
Pattern Fill areas  contain small stitches with repeating patterns. Select from one of the 
themed categories, or import a picture as a My Fill pattern. A pattern fill area can have 
holes defined inside it. The stitches can be at any angle and the density can be constant, 
gradient or multicolor as desired. Constant density fill areas can also have automatic 
underlay, which is turned off automatically for gradient density areas.

If you change a gradient density fill back to standard, then you should also select the desired underlay.

Shape Fill
Shape Fill areas  use one of 75 different shapes. Vary the stitch density, use running 
stitch or motif lines for the fill and add holes.

Fill Area with Satin border and holes 
using Pattern Fill 109 from Hearts

Pattern Fill Area with Multicolor 
Gradient

Motif Fill Area with two motifs, 13 
and 19, from Hand Stitches 2

Shape Fill Area using Shape 23 
and Motif 1 from Hand Stitches 1

Radial Fill with origin moved to top 
of heart

Spiral Fill using Gradient Density
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Motif Fill
Motif Fill areas  contain repeated small stitches placed using one of the Universal or 
machine motif patterns. A motif fill area can also have holes defined inside it. Motifs can 
be at any angle and at different sizes, and different motifs can be used on alternating lines.

Radial Fill
Radial Fill areas  use a pattern of radiating lines from an origin point that can be moved. 
Vary the stitch density and add holes.

Spiral Fill
Spiral Fill areas  use a spiral pattern from an origin point that can be moved. Use 
constant or gradient density, and add holes.

QuiltStipple Fill
QuiltStipple Fill areas  use stipple stitch in curved or straight lines. Vary the gap 
between stitch lines, use running or triple stitch, and add holes.

Contour Fill
Contour Fill areas  use contour stitch lines. Vary the gap between stitch lines and the 
length of the stitches, use running, double or triple stitch, and add holes.

Crosshatch Fill
Crosshatch Fill areas  use diamond, square and parallel crosshatch patterns, or select 
the angles for the crosshatch. Set the gap, style, line angle, stitch type and stitch length for 
the crosshatching, and add holes to the fill.

Crosshatch fill is often selected for lace designs, typically using a Double Zigzag stitch type.

MultiWave Fill
MultiWave Fill areas  use a wave pattern defined by a line, or lines, drawn on the fill 
area. Vary the density, or use a motif for the stitch lines.

Echo Fill
Echo Fill  places echo lines within and/or around a shape. Choose from rounded, square 
and diagonal corners, set the gap between the echo lines and the number of lines, and 
select the stitch type and length.

QuiltStipple Fill using a curved 
style

Contour Fill, using Triple Stitch and 
a 3.0mm gap

Crosshatch Fill, using Diamond 
style and an Angle of 75 degrees



26          PREMIER+™ 2 Create   Creating Design Elements 

Curved Crosshatch Fill
Curved Crosshatch Fill areas  use curving lines in the crosshatch, which can be used to 
create a feeling of depth. They are used in quilting, and to create free-standing lace.

Satin Areas
Satin Areas  contain zigzag stitches that fill the area from one 
end to the other at the same density. The stitch angle changes 
with the shape of the area, and can be adjusted as desired. 
Choose automatic edge walk and/or zigzag underlay, and if 
desired select a pattern.

Satin Areas can be converted into any type of fill area. They cannot be 
created with a border, but a border can be placed around them using the 
Fill Area and Line properties dialog.

Columns
Create Columns by placing points, or on the Precise Create tab by drawing Bezier lines. 
The Column functions are found both on the Freehand and Precise Create tabs. Place 
alternate points to define a column of any length.

Columns may be converted into Satin Areas using the Convert to Satin Area  option, but Satin Areas 
cannot be converted into any type of column.

Satin Column
Use Satin Column  to create a straight or curving column of parallel stitches. The 
column may be of any length. If desired, add a pattern. Choose from over 250 patterns, 

Curved Crosshatch Fill, using 
Square style and a Gap of 5mm

MultiWave Fill, using a density of 15, 
a MultiWave Line, and a Hand 

Stitches 1, Pattern 1 motif

Echo Fill using Internal and 
External Lines, and rounded 

corners

Satin Column Feathered Satin Richelieu Bars Tapered Motifs
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similar to Pattern Fill, or create your own My Fill patterns. The density can be constant, 
gradient or multicolor as desired.

The recommended maximum length for satin stitches is around 8-10mm, otherwise the stitches may be 
loose and not lie flat. To create satin wider than this, use a pattern, overlap satin columns, or use a satin 
area.

Feathered Satin
For lifelike realistic feathers or fur, use Feathered Satin , where the start and end points 
of the stitches are random rather than all parallel. Feathered satin may also be created 
with only one side feathered – the side where the first (A) or second (B) point was placed.

Richelieu Bars
Use Richelieu Bars  to create a column of short sections of satin perpendicular to the 
direction of the column. Choose the number of bars, and the width of the satin. Richelieu 
bars are typically used for cutwork designs.

Tapered Motifs
Use Tapered Motifs  to create a line of motifs that vary in size according to the width of 
the column. Tapered motifs are often used in lace designs.

Line Types
Choose a line type before drawing the line, or change it afterwards in Fill Area and Line 
properties.

Running, Double and Triple Stitches
Set Running Stitch  from 0.3-12.0 mm in 0.1mm steps (standard, or cutwork needle 
lines with secure points). Set Double , Double Zigzag  and Triple  Stitch to any 
length from 1mm to 12mm.

Double Zigzag is a special stitch type, recommended for lace. A running stitch line is retraced in a zigzag 
pattern to create a mesh.

Feathered Both Sides Feathered Side A Feathered Side B

Running Double Triple
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Motif Line
Motif Lines  are lines of the chosen Universal or machine 
motif patterns.

Satin Line
Create Satin Lines  where a line or border of satin stitches of constant width is desired. 
The line will be created along the center of the chosen line.

Individual satin lines and the satin borders used around fills or appliqué are identical.

Appliqué
Select Appliqué  to use appliqué fabric and placement stitches with a fill area that you 
create. Select an appliqué fabric in the Appliqué Selection dialog box, and choose a 
placement method in the Fill Area and Line options Appliqué tab.

Commands
Commands are instructions such as the Color Change  that changes the thread at the 
start of a new color block. The Stop  tells an embroidery machine to stop without a 
color change. 

Color changes, stops and alignment stitches are indicated by special blue, red and pink 
markers when in 2D or Object mode.

Alignment Stitches
Use Alignment Stitches  to add stitches at the beginning of an embroidery that you can 
use to align the embroidery, for example if it is being stitched over a background picture.

Alignment Stitches are typically placed at the beginning of an embroidery. They will be 
inserted after the currently selected object, but may be moved if desired. Alignment 
Stitches are created as a cross, but may be altered after placement.

Color Change Stop Alignment Stitch
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Single Stitch
Use Single Stitch  to create single stitches that will be 
embroidered at whatever length they are made. 
Alternatively, if you select to Break Up into Smaller Stitches 
they will be broken up into stitches of Running Stitch at any 
length from 1 to 12mm.

Single stitches cannot be converted to any other line type.

Creating Motifs, Machine Stitches and Stamps
In the Draw window, create a drawing that will be suitable as a repeated element. You can 
then export the selected area as a My Motif  for use in any motif line or fill type, or as a 
.spx machine stitch  for certain sewing machines. Save the drawing in .4qb format in 
case you wish to edit it later, or use it as a stamp in PREMIER+™ 2 Modify.

The Reverse Path function on the Draw tab is useful if you copy, paste and mirror part of the drawing.
Import motifs  to change or combine them, or to save them as machine stitches. Import 
machine stitches  to create motifs. See “Motifs, Machine Stitches and Stamps” on 
page 53.

Fill Area and Line Properties
Use the Fill Area and Line properties dialog box to change the fill and line type for a 
previously created area. Then edit the properties using the tabs in the dialog.

The options available in the two drop-down lists vary, depending upon the selected fill and line type.
You can change a previously created area to any other fill or line type in the drop-down lists, including No 
Fill or No Border Line.

Choose a fill type
Choose a line type
Change the line or fill properties

Set the appliqué method
Set options for your favorites

Select a fill category and pattern
Use a Gradient fill

Set the properties for a gradient fill

Click Apply to preview and OK 
to finalize your changes

Set underlay, angle and compensation
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To access the Fill Area and Line properties dialog, click the Fill Area and Line button in the 
Options area of one of the Create tabs. Alternatively, right-click an existing line or fill on 
the FilmStrip or in the work area.

If accessed from the Options button, you cannot change the fill and/or line type.

Line
Click the Line tab and select Insert Color Change for a different color for a fill area border. 

Appliqué
Select the appliqué method before or after 
creating an area or line. Choose from:

• None
• Standard Appliqué
• Pre-cut Piece
• Pre-placed Piece
• Cut-out

Use Select Fabric to choose a fabric for your appliqué in the Appliqué Selection dialog box.

Set the margin for appliqué placement relative to the drawn border shape from -10mm to 
10mm. The initial value is 1.0mm.

Use a positive value when trimming the appliqué fabric before the border is stitched, for example with 
Standard Appliqué and Pre-placed Appliqué. A negative value is recommended for cut-out and reverse 
appliqué.

Favorites
Use the Favorites tab of the Fill Area and Line properties dialog to make the chosen 
settings into favorites, or to return to the original settings.

Use ’Save these options as my favorite’  to save the chosen options as the favorite for 
this area or line type.

The favorite option must always be applied from the Favorites tab. It is not the same as the current settings, 
used to create new areas.

Column Properties
Use the Column properties dialog to change the column type for a previously created 
area. Then edit the properties for the selected column type using the Options tab. Use the 
Favorites tab to select favorites, or to return to the original settings.

You can change a previously created column to any other column type in the drop-down list. Use Convert 

to Satin Area  to change to a satin area.

To access the Column properties dialog before creation, select one of the Column options 
in the Options section of the Freehand Create or Precise Create tab. After creating stitches, 
right-click an existing selected column on the FilmStrip or in the work area.

If accessed from the Options button, you cannot change the column type.
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Object Properties
The following settings can be changed for stitch objects before or after they are created:

 Density
 Compensation
 Underlay
 Stitch Length
 Satin Line Width
 Fill and Satin Patterns
 Gap and Shape
 Start, End and Origin
 Motif
 Feathered Side
 Alignment Stitch Type

The settings for new areas and lines are set by selecting a stitch type in the Options area of 
the Create tab and adjusting them in the properties dialog for that stitch type. 
Alternatively, select an area with the desired properties and save them as your Favorite  
or Current  settings.

Not all settings can be changed for all stitch types. Options that set properties for new objects are only 
applied when using the Create tabs to make stitch objects. Objects created in the ExpressDesign Wizard do 
not use the current settings, but may be changed after finishing the wizard.

Density
Density of stitching may be set from 2 to 40, except for Pattern Fills , Spiral Fills , 
Satin Column  and Satin Area  (2 to 80), and Richelieu Bars  and Satin Line  (2 
to 15).

Choose a column type

Change the properties as desired

Click Apply to preview and OK 
to finalize your changes
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Pattern  and Spiral  Fill areas and Satin Columns  may also have density gradients, 
or variable multi-density. The higher the number, the farther apart the stitches and the 
fewer stitches are produced. Pattern fills and Satin Columns may also have multicolor 
gradient density.

Embroidery on thicker fabrics usually looks better with more stitch coverage, or a low density setting. 
Choose a low value such as 2 or 3 for heavy knit fabrics, a higher value such as 5 or 6 for a light material like 
linen or satin. 

Compensation
All stitches have a tendency to pull in. The pull varies according to fabric weight and type. 
Compensation is used to make a whole design or areas within it 'bolder' by increasing 
their relative size. The higher the number, the bolder the areas appear. You can also alter 
compensation for any individual area of satin or fill.

Embroidery on thicker fabrics usually looks better with higher compensation, while on thin materials such 
as satin or twill a lower value or zero setting is usually more appropriate. As you create a design, use 
overlaps to prevent pulling from creating gaps between blocks of stitches that have different stitch 
directions. This provides 'built-in' compensation.
Compensation may be set from 0 to 30 for satin and 0 to 20 for fill areas. The setting for any 
Satin Column , Satin Area  and Pattern Fill  in the design is shown in the Area and 
Line properties for that satin or fill.

Compensation does not apply to feathered satin, satin line, or any fill other than pattern fill.

Underlay
Underlay is used to stabilize an area of fabric before stitching over it. Automatic underlay is 
optionally available for Pattern Fill areas, Satin Areas, Satin Column, Richelieu Bars and 
Satin Line. To create underlay for other object types, use running stitch or single stitches.

Satin Compensation Pattern Fill Compensation
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Embroidery designs created with the ExpressDesign Wizard have an option to create underlay for the 
whole design.

Stitch Length
Stitch Length can vary according to the object type as follows:

 Single Stitches : each stitch may be set from 1-12mm in 1mm steps, or embroidered 
without breaking up into smaller stitches.
The current maximum stitch length for new Single stitches, if it is desired to break them up into smaller 

stitches, is shown in the Preferences .

 Running Stitch may be set from 0.3-12.0mm in 0.1mm steps.
Cutwork needle lines are automatically set to 0.3mm.

 Double Stitch , Double Zigzag  and Triple Stitch  may be set from 1-12mm in 
0.1mm steps.

 Motif Line  stitches may be set from 1-20mm in 0.1mm steps.

 Motif Fill : the length of the running or triple stitches making the motif shapes can be 
set from 1-12mm in 0.1mm steps.

 Feathered Satin  (feathered both sides or one side): the maximum length of the stitches 
may be set from 2-30mm in 1mm steps.

 MultiWave Fill and Shape Fill : where Motifs are used, the length of the running or triple 
stitches making the motifs can be set from 1-12mm in 0.1mm steps.

 QuiltStipple , Contour , Crosshatch , Curved Crosshatch  and Echo  Fill: the 
length of the running or triple stitches making the fill can be set from 1-12mm in 0.1mm 
steps.

Satin Line Width
Satin line or border width may be set from 1 to 12mm in 
0.1mm steps.

Fill and Satin Patterns
Choose from over 250 system patterns or any imported My Fill pattern for Pattern Fill 
areas, Satin Areas and Satin Columns. Choose any available motif for motif fill areas, lines 
and tapered motifs columns. 

Patterns in categories other than Standard are recommended for use in relatively 
large fill areas, as they have repeating patterns which work well when 'tiled' 
together. Pattern 36 produces a 'satin effect' fill stitch. The first four patterns in the 
Gradient & Lace category (253-256) are recommended for multicolor gradient. The 
other eight (257-264) are suitable for a weave pattern combined with parallel 
crosshatch, as used for lace designs.

Set the angle of orientation for the stitches in Pattern, Motif and 
Crosshatch and Curved Crosshatch fill areas to any degree. 

Gap and Shape
The QuiltStipple , Contour , Shape , Crosshatch , Curved Crosshatch  and 
Echo  styles of fill have additional properties that are unique to these fill styles. 
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QuiltStipple fills can have curved or straight stipple stitching, and a gap setting controls 
the spacing of the lines of stipple stitch. Contour fill also uses a gap setting that controls 
the spacing of the lines of Contour stitch. Shape fills have a choice of 75 shapes, which 
control the path of the stitching. Crosshatch and Curved Crosshatch fills can use diamond, 
square and parallel styles. They have a gap setting that controls the spacing between the 
lines in the crosshatch. Echo fills can use internal or external lines, varying the number or 
spacing. They also have a choice of three styles, with curved, square or diagonal corners.

Richelieu Bars may have a minimum gap or number of bars specified.

Start, End and Origin
Fill and satin areas have adjustable green start  and red end  points, which can be 
moved to any point defining the shape of the area. Use this to control the connection 
between an area and the objects that precede or follow it. For example, this is useful for 
shortening or hiding movement stitches so the need for trimming is reduced.

Pattern, Shape, Radial and Spiral fill areas also have an orange origin . For Pattern Fill, 
the origin marker also has an adjustment handle .

In a pattern fill area, the origin is the start point for the repeating pattern. In Shape, Radial and Spiral fills, 
the origin is the point from which stitches radiate. For a pattern fill area, move the origin to change the 
position of the pattern, and rotate the handle to change the angle. For Shape, Radial and Spiral fills, move 
the origin to move the radiation point of the fill. The origin may be moved anywhere on the work area.

Motif
Choose any available motif for Motif Fill areas  and Lines . Motifs can also be used in 
Shape , MultiWave  and Curved Crosshatch  fills, and tapered motifs columns . 
The size of motifs can be changed, and they can be stitched in either running or triple 
stitch. For motif fill areas, a second motif can be chosen for alternating lines, and the 
spacing, offset and angle of lines can be changed.

Feathered Side
Individual areas that were created as both sides feathered, Feather Side A or Feather Side B 
may have their feathered edges changed. See “Feathered Satin” on page 27.

Alignment Stitch Type
Alignment stitches are added at the beginning of an embroidery to align it, for example, 
with a background picture on fabric. They are initially placed as a cross . Use the 
Alignment Stitches properties dialog to change the stitch type. Select the desired stitch 
and right-click to choose from cross , top left , top right , bottom left , bottom 
right  and point .

Global Properties
The properties of all visible objects of a chosen type can be changed with Global 
Properties. Global Properties is only available if a single object is selected.

Global Properties is not used for Stops, and has no effect on Color Changes. 
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Change Properties for Selected Objects
The properties of all selected objects of a chosen type can be changed at once.

You cannot change properties for multiple Stops or Color Changes at the same time. If more than one type 
of object is selected, only the object selected first will have its properties changed.

Design Size and Creating Embroideries
The purpose of creating a design is to generate an embroidery from the finished design. 
Before creating an embroidery you may wish to consider how the design size will affect 
the finished embroidery.

The size of a design is mainly controlled by the hoop size used.

You can create a design for many different hoop sizes from the same design outline (.edo) file. However, 
you need to consider how this will affect the size of individual parts. For example, a satin line for an 
embroidery size of 150mm may look better as a running stitch line if the embroidery size is 80mm. The 
recommended maximum length for satin stitches is around 8-10mm, otherwise the stitches may be loose 
and not lie flat. To create a satin sections wider than this, either overlap satin sections, or use one of the fill 
patterns to create smaller alternating stitches
When creating designs, remember the outside edge of some stitch types may extend 
beyond the hoop. For example, satin borders have stitches generated on both sides of the 
center line and feathered satin sections have stitches that go beyond the points placed to 
define the feathered satin. The design size is measured according to the distance between 
the outermost control points. However, the embroidery may be larger than the desired 
design area or hoop size if stitches are created that extend beyond the outermost points, 
as in the example. This is easy to see in 3D View, but in Object View you could create areas 
that are too large without realizing.

You will be able to save the design outline file, but if you select Export Embroidery a 
message will appear: Embroidery is too large or will not fit in hoop. Click OK to continue.

Change to a larger hoop  to stitch out the design, or in the Modify Block menu on the 
Home tab, select Scale Fit to Hoop  to automatically adjust the actual size of the design 
to fit in the hoop.

Use Change Design Size  to alter a design automatically to a new size, allowing for the 
stitch objects used such as satin borders.

The stitches created go outside the hoop. The points for both the satin line and 
feathered satin are inside the hoop.
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5Editing a Design
Use the Edit tab to view colors, to display and hide objects in the design, and to edit parts 
of the design. 

Select Objects
In PREMIER+™ 2 Create, designs are made up of a sequence of lines and areas (e.g. stitch 
lines, fills and columns). Each area, line or column is defined by a number of points that 
can be seen on the work area. The selected object is highlighted in the FilmStrip in the 
Design window.

Select a Place to Insert New Objects
To add stitch objects such as areas, lines and columns between existing objects, select an 
object in the FilmStrip or work area, then create the new object. The new object is placed 
below the object that you selected. If you select an object within a group, the new objects 
will be created as part of that group.

Unless you choose a new color, the color of newly inserted objects will be the same as the object above 
them.
Use the display options on the Edit tab or the right-click context menu to hide objects that 
you do not want to change. 

The color worksheet, object filters and Draw Range are also useful to isolate an object so 
that it is easier to select the desired insertion point.

Insertion Markers
When a Freehand Create or Precise Create tool is selected, a marker shows the location of 
the last point of the preceding object. This is where new objects will be inserted:

 When objects will be added to the end of the design, the marker is pink .
 When objects are to be inserted (i.e. the selected object is not the last object in the 

design), the marker showing the final point of the selected object is orange .

 When objects are to be inserted, a blue marker  shows the position of the first point in 
the next object in the design.

Show only the previous or next color in the design
Display all objects in the design

Set Start & End markers to display an object range
Remove an enhancement from a fill area

Show and hide particular object types

Show selected objects

Set the properties for the selected object(s)
Create and manage fill patterns

Edit individual objects
Select objects similar to the one selected
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Select an Object to Edit
In the work area, click on an individual object to show the points that make it up and 
check what type it is in the Object Identification Box on the bottom right of the status bar. 

The object is also highlighted in the FilmStrip. You may click the desired object in the FilmStrip and the 
object will be selected on the work area.
If you click on an object in a group, the whole group will be selected and highlighted in 
the FilmStrip. To select an object within that group, click on it in the FilmStrip.

To edit the shape of a selected object within a group, right-click on the work area to enter Edit Points mode. 
Then adjust its shape.
After locating the desired object, click and drag its points to change the shape of the 
object. In the Home tab you can insert extra points , delete unwanted points  or 
delete the object . 

Alternatively, right-click to access a dialog box to alter its properties, such as Fill Pattern or Stitch Length.

Stepping Through Designs
In Edit Points mode, use the left and right arrow keys on the keyboard to step through all 
the objects in sequence. Alternatively, click an object in the FilmStrip and use the up and 
down arrow keys on the keyboard to step through all the objects in sequence. 

If you are in Box Select mode , the selected object will move in the work area. Right-click on the work 
area to enter Edit Points mode.
Use Delete  to remove the currently selected object(s) from the design. To delete 
commands, use the left and right arrow keys on the keyboard to step through all the 
objects in sequence until the desired command is selected. Alternatively, select the 
desired command using the FilmStrip.

Insert Commands
Use the FilmStrip to insert a new Color Change or Stop immediately after the selected 
object. Right-click in the film strip, then select the desired option from the context menu 
that appears.

Use Insert a Color Change  to insert a color change after the currently selected object. 
The Color Selection dialog box appears so you can choose the new color.

Use Insert a Stop  to insert a Stop command after the currently selected object.

A Stop will not be inserted if this would place two Stops together.

Change Objects’ Sequence
Objects may be moved up and down the FilmStrip with click and drag, 
or with the arrow (Layout Order) buttons. This changes the order of the 
objects, and hence changes the order in which the stitches are created for the final 
embroidery.

To move a selection of objects, either click the top of a sequence then hold the Shift key 
and click the bottom of the desired sequence, or hold the Ctrl key and click the desired 
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objects. Then click the desired Layout Order button. Alternatively, use click and drag by 
moving the bar up or down the list to the desired point, then release the mouse button.

If desired, use the color worksheet and Hide Object Types buttons to hide other objects. This can make it 
quicker to move the desired object.
If objects are dragged or inserted between two items in a group they will become part of that group, except 
if they are inserted immediately after the group header. To insert at the beginning of the group, drag into 
the middle, then move up.
When using click and drag to move to a part of the list that is not visible, move the pointer 
above the top or below the bottom of the list and the list will scroll automatically. To scroll 
faster, move the pointer further above or below the list. Move the pointer back into the list 
to stop scrolling.

Moving an object up and down the FilmStrip does not change the position of the object 
on the work area. However, it may change the appearance of the design according to 
whether or not it changes the overlap with adjacent objects.

The first color change may not be moved in the FilmStrip. Also, no object may be moved above the first 
color change in the FilmStrip, except another color change. This ensures that the initial color change in the 
design cannot be removed, and nothing can be moved before it, but it can be replaced.
Use Display Group Contents  to switch between viewing the objects within Groups in 
the FilmStrip, and seeing only the Group heading rows in the FilmStrip.

Deselect Display Group Contents to aid in moving groups within the design.

Edit Lines and Areas
The shape of a line or area can be changed 
by moving the points that define its 
outline.

To choose a different object, click it on the 
work area or the FilmStrip. Alternatively, 
use the left and right arrow keys to step 
through the objects in the order they are 
used in the design. When selecting an 
object directly on the work area, click near 
one of the points that define it.

If the visible colors or the object filters are changed, the last visible object is automatically selected. 
Therefore, change the view of the design before selecting the object you wish to edit. See “Viewing 
Designs” on page 17.
When the desired line or area is selected, its points can be moved. The points are shown as 
small circles or squares. Some stitch object types, such as Single Stitches have a fixed 
number of points.

Square points are used for straight sections and corners. Round points are used for curves.
Other objects, such as fill areas, running stitch and satin lines, can have any number of 
points, and points may be inserted and deleted, allowing greater control over their 
shapes. The start and end points for fill and satin areas can be changed, typically to reduce 
the need for trimming. Satin areas have angle lines that are used to control the satin angle.
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Color change and stop commands, and alignment stitches are shown as a single point 
when selected.

Move Points
The points that define the currently selected stitch object (satin column, fill area, running 
stitch, etc.) are shown as small squares and circles.

Also, the object type is shown in the FilmStrip and on the status bar. The FilmStrip also 
shows the shape of stitch objects, where relevant. The points used to start and end fill and 
satin areas are shown by the start  and end  markers. Some types of fill areas also 
have an origin, marked by a orange circle  (for Pattern Fill, the marker has a handle). 
Satin areas also have stitch angle lines with hexagonal ends.Once the points are shown, 
click and drag the squares or circles to move them.

Moving the points that define a satin area may also affect the stitch angle lines, but moving the stitch 
angle lines does not affect the shape of a satin area.

Edit Points
Use Edit Points  to enable the moving and editing of an object’s points if another 
function is being used. Alternatively, click an object to select it and you will be in Edit 
Points mode.

Make Lines Straight or Curved
The outlines defining most types of lines and areas can have both curved and straight 
sections:

To have any curves, lines must be defined by at least four points. The first point of a fill or 
satin area is always a 'corner' (square) point. The first and last pair of points for a column 
are always square.

To change a curve (round) point to a square point, hold down the Ctrl key and click the 
point without moving it. When adjacent points are corners, the line between them will be 
straight. This is useful if, for instance, a point was not added as a corner at the desired 
place on a fill area or stitch line.

Fill areas have as many points as needed to define 
their outlines, and also have moveable start, end and 

origin markers

Satin areas have moveable start and end markers 
and adjustable stitch angle lines

Start
Marker

Origin
Marker

End
Marker

Start
Marker

End Marker

Stitch Angle
Lines
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To change a corner point to a curve (round) point, simply click the point without moving 
it. There must be at least two round points next to each other to make the lines curved, so 
if there is one round point between two square points then the lines to the round point 
will be straight.

If a line does not have enough points to make the desired section curved, use Insert Point  to add an 
extra point to use for the curve.

Move the Start and End Points for Areas
The start and end points for fill and satin areas are shown by circular markers. The start 
marker  is on the inside of the object, and the end marker  is on the outside of the 
object.

Click and drag the desired marker. Move the marker to the point that you wish to use as 
the new start or end point of the area. Drop at the desired point and the position of the 
marker will change.

The marker snaps to the nearest point on the edge of the object. To add a point, use Insert Points .

Move the Origin for Areas
Some types of fill areas have an origin, marked by a orange 
circle . This is used to move the start point for the pattern in a 
pattern fill, or the center point for Radial fill, Spiral fill and Shape 
fill types. For a pattern fill, the origin has a handle for adjusting the 
angle of the fill.

This means that in a pattern fill area you can control how the pattern is 
repeated, and its angle.
For Radial fill, Spiral fill and 
Shape fill areas, the origin can 
be moved. This sets the start 
point for the fill, such as the 
point from which stitches 
radiate on a Radial fill.

The origin can be moved 
anywhere on the design area. 
This allows you, for example, 
to create several of the same 

Point is a curve Point is a corner after Ctrl + click
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types of fill area with a common origin. Simply move the origin to the same grid position 
for all the desired areas, so that the pattern of stitches is unified across the chosen areas.

Change the Stitch Angle for Satin Areas
Satin areas have stitch angle lines that show and 
adjust the angle of the stitches across the area. The 
stitch angle lines have hexagonal handles at each end 
that are used to adjust each line individually.

Click and drag the desired hexagonal handle. Drop at 
the desired point and the position of the angle line will change. If the line does not move, 
this is because the new end point is not usable. This will happen if, for example, you 
attempt to force two angle lines to cross each other within the area.

To delete angle lines, click Delete Points  then click the hexagon at either end of the line 
to be deleted. Right-click when you have finished deleting angle lines and/or points.

Inserting and Deleting Points
Use Insert Points  to add a new point to the currently selected line.

Points may be inserted into all line and area types except Single Stitch. With this object type Insert Points 
and Delete Points are not available. For columns, a pair of points will be added.
Points may also be inserted into emboss lines and MultiWave lines.
Click the Insert Points icon , then click the position on the selected object where you 
want to add the point. Also use Insert Points to add stitch angle lines to satin areas with 
click and drag. 

Use Delete Points  to delete points from the currently selected line. 

Points may be deleted from all line and area types except Single Stitch. For columns, a pair of points will be 
deleted. Points may also be deleted from emboss lines and MultiWave lines.
Click the Delete Points icon , then click the points on the selected object that you want 
to delete. Right-click to finish.

You may not delete all the points for an object. A fill or satin area must have at least three points. Satin 
border, motif lines and running, double and triple stitch lines must have at least two points. A satin area 

must also have at least one angle line. To remove all the points for an object, use Delete .

Convert Points and Bezier Lines
Use the Convert Points  functions to change between types of points in a line in Bezier 
Mode, or to change a Point Line to a Bezier Line, or a Bezier Line to a Point Line.

For information on how to draw and adjust Bezier Lines, see the PREMIER+™ 2 Create Reference Guide.
Use Convert Points to Corner  to change the selected point in a Bezier line to a Corner 
point (a point with no handles). Right-click to deselect the function.

Use Convert Points to Smooth  to change the selected point in a Bezier line to a Smooth 
point (a point with handles that can be adjusted independently). Right-click to deselect.

Use Convert Points to Symmetric  to change the selected point in a Bezier line to a 
Symmetric point (a point with handles that are the same distance from the point). 
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Delete Holes, Emboss Lines, and MultiWave Lines
Use the Delete  drop-down menu on the Edit tab to delete one or more holes  or 
emboss lines  from the currently selected area, or one or more MultiWave lines  from 
the currently selected MultiWave Fill area.

Select a Block of Objects
The select functions on the Home tab allow you to select a block of objects. A selected 
block of objects can be resized, rotated, mirrored, moved, copied and cut. You may find it 
easier to select a block when you have selected colors to display and/or changed the 
range of objects that are visible. When a block has been selected, it has a selection box 
around it. The selection box has blue handles which are used to resize, rotate and flip.

The handles are blue because you can freely manipulate the selection without changing density or stitch 
length in the objects. This is because the stitches are only generated when you use Export Embroidery.
Click and drag inside the block to move it. 
Click and drag the square corner handles  
to resize the block. Hold down the Ctrl key as 
you click and drag to resize proportionally. 
Hold down Shift to resize from the center. 
Click and drag the round rotate handle  to 
rotate the block freely. Click and drag the 
center of rotation  to rotate around a 
different point. Click the triangular handles to 
flip the block horizontally  or vertically .

Use Rotate 45  to rotate the selected block 
of objects in 45 degree steps. If desired, move the center of rotation  before rotating.

Use Modify Block  to open the Modify Block dialog, where you can show and change 
the size, rotation and skew of the currently selected block. If no objects are selected, the 
whole design will be modified.

When making a selection, only objects that are completely enclosed by the selection line will be included in 
the selection. You will often need to cross Running stitches to make a selection. These objects would not be 
included because you have not completely enclosed them.
When a new selection is added to a design by paste or one of the insert functions, it is 
automatically selected as the current block and Box Select is activated. Click the work area 
outside a block to deselect. Right-click to deselect a block and turn off the select function.

Use Select Last Visible  on the FilmStrip to select the last object that has not been 
hidden by Color Select, any of the object Filters, or the End slider.

Selection Tools
Only objects that are completely enclosed by a selection line will be selected. 
With Box Select , click and drag to draw a rectangle around the area you want to select. 
Box Select is also activated automatically when a block is pasted into a design.

With Freehand Point Select , click a series of points to create an irregular outline of 
straight or curved lines around the desired area. 

Flip Vertical Handle

Rotate
Handle

Resize
Handle

Center of
Rotation

Flip
Horizontal

Handle
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With Freehand Select , click and drag to draw an outline around the desired area. 

Select All Visible  is a one-click function that selects all visible objects in the design.

Use Replace Selection  to replace the currently selected objects with the new selection. 
Use Add to Selection  to add the new selection to the currently selected objects. Use 
Remove from Selection  to remove the new selection from the selected objects.

Multiple Select and Groups
Multiple Select
Use multiple select to select more than one object at a time. In the FilmStrip, hold down 
the Ctrl key and click the desired objects. A selection box will be placed around the 
selected objects. Alternatively, use one of the multiple select tools in the Select area. The 
selected objects are surrounded by a selection box with a solid outline, and blue handles. 
Lettering, SuperDesigns and inserted embroideries retain their orange (Group) handles. 
The whole selection can be scaled, rotated and mirrored. 

If you click outside the selection box, the designs will become separate. Use Undo , or select them again.

In PREMIER+™ 2 Create, you can edit objects individually, in a selected block, or in groups 
which remain as a selection after saving. To reshape or change the properties of an 
individual object inside a group, select it on the FilmStrip.

When a design including groups is loaded using Insert  or Open , all sections will be grouped.

Group
Use Group  to make a more permanent group of 
all the currently selected objects. Use Group to 
group the objects permanently, or to make a 
temporary Group while moving or editing them.

A group can be modified in the same way as a selection
The grouped objects are surrounded by a selection 
box with a solid outline, and orange handles. The 
group can be scaled, rotated and mirrored.

If you click outside the selection box, and then click one of 
the objects within the group, the objects will still be grouped.
Use Ungroup  to split the currently selected 
group into the objects which make it up.

Use Select Similar from Visible  to select all visible objects with similar properties (i.e. 
the same name in the FilmStrip); for example, select all Radial Fill areas, or all Satin Lines.

Use Select Similar from Group  to select all objects with similar properties (i.e. the same 
name in the FilmStrip) that are in the same Group.

Objects with similar properties that are in a different Group, or in no Group will not be selected.
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Cut, Copy, Paste, Duplicate and Insert Objects
Once objects have been selected, they can be cut and copied. Only objects that are 
completely enclosed by the selection line will be selected. The selection of objects on the 
clipboard can be pasted as many times as desired in the Design window, or into a separate 
PREMIER+™ 2 Create window.

Use Delete  to remove a block of objects from the design. 
Use Cut  to cut out the selected objects and place them on the clipboard.

Use Copy  to Copy the selected objects to the clipboard, without affecting the current 
selection. If no objects are selected, the whole design will be copied.

Use Paste  or Paste and Replace in the Home tab to paste the objects on the clipboard 
back into the design, or into a separate PREMIER+™ 2 Create window. The first object in 
the block is placed in the same position on the work area after the selected object or the 
last visible object in the design. Alternatively, use Paste into Center .

Color Changes are only transferred if they are within the copied block. If there are no Color Changes in a 
pasted block then all the objects will use the thread color already in use where the block is pasted.
Embroideries copied from other PREMIER+™ 2 Embroidery System modules may not be pasted into 
PREMIER+™ 2 Create, but you can use Insert Embroidery  to import embroideries from other modules, 
and move a design to another module with Copy Embroidery .

Use Duplicate  to make a copy of the selected objects, which is automatically pasted on 
the work area below and to the right of the original and after the selected objects in the 
stitch sequence. 

Insert Embroidery
Use Insert Embroidery  to insert any embroidery into the current design. An inserted 
embroidery is automatically converted to stitch objects and placed as a group. The first 
object in the group is placed after the selected object or the last visible object in the 
design. Embroideries are inserted at the size they were created, or automatically made 
small enough to fit the current hoop.
To insert an .edo or .can design outline file, use Insert .

Insert Lettering
Use Insert Lettering  to insert lettering from any PREMIER+™ 2 Embroidery System font 
into the current design. The first object in the inserted character is placed after the 
selected object or the last visible object in the design. The character is also placed as a 
group so that it can be moved, resized, mirrored, rotated, copied or cut. Characters are 
inserted at the selected size relative to the 'A' character in the font.

Insert SuperDesign
Use Insert SuperDesign  to insert a SuperDesign from the SuperDesign sets available in 
PREMIER+™ 2 Create. SuperDesigns are special designs that can be resized with constant 
stitch density. Some SuperDesigns are multicolored, and the stitch type and style for many 
can be changed. Alter the size, proportions, stitch type and thread color. 

Choose a Style for certain SuperDesign sets, for example the Animals 1 set contains 
Natural, Sepia and Line styles.
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6Creating a Drawing
A full range of drawing functions is available for vector graphics files (easily resizable 
images using lines, curves and shapes). In addition to the standard features, PREMIER+™ 2 
Create includes Send To Wizard , which enables you to convert your vector drawing 
directly into an embroidery (.edo) design.

Use the Draw tab to select, organize and edit your drawing, and to create motifs and 
machine stitches.

Use the Draw window control panel to select colors, draw lines and fill areas, and add 
clipart, shapes and letters to your drawing, and to edit its lines and fill areas.

Lines are converted to running (0.5 or 1mm), triple (2mm), or satin (3mm or above) depending on their 
width. Filled areas are converted to pattern fill.

Use a selection tool to choose part or all of the drawing

Make a Group of the selected objects, or Ungroup grouped objects
Merge lines with Combine Paths to create shapes or holes 

Cut, copy, paste or delete the selected objects

Repeat the selected design

Adjust or rotate the selected objects

Create motifs and machine stitches

Show the FilmStrip & Grid

View and swap the line and fill colors

Pick the line color, or match a line color to the shade in the Color Box

Pick a fill color, or match a fill color to the shade in the Color Box
Choose a color theme

Pick a color from the palette

Select the line width, or use a fill area with no surrounding line

Choose whether to use a fill within a closed line (shape) 

Draw smooth or angular lines, or add shapes to your drawing

Add clipart or text to your drawing

Add, remove, or adjust the nodes in a line or cut a line with the Knife 

Choose the settings for the selected Create tool

View the contents of the Clipboard
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Choose Drawing Colors
Use the Color box and Color palette to choose 
the colors for drawing Lines and Fills.

The Color box displays the currently selected Line 
and Fill colors. The top color is the Line color and 
the bottom color is the Fill color.

 Left-click on a color from the Color palette to select it as the Line color.
 Right-click on a color from the Color palette to select it as the Fill color.
 To choose a color that is not in the Color palette, double-click on either of the colors in the 

Color box to bring up the Colors dialog box. (After a color is chosen, it will be placed as 
Line or Fill color depending on which color was clicked in the Color box.)

 To select a color from the picture on the screen use Pick Line Color  or Pick Fill Color .

Themes
To alter the range of colors in the Color palette, click the Theme drop-down list and select 
one of the themes: Standard, Spring, Summer, Fall and Winter. Use Edit Themes to create 
and select personal color palettes. 

Match Line Color
Use Match Line Color  to change the color of an existing line.

1 Use Freehand Draw  to draw a line in the drawing area.
2 Select a new color from the Color palette.
3 Click the Match Line Color icon .
4 Click the line that you drew. It is filled with the new color.

Match Line Color and Match Fill color are enabled until another tool is selected.

Match Fill Color
Use Match Fill Color  to change the color of an existing fill. 

1 Select Line and Fill colors.
2 Click Shapes Draw , then click and drag in the drawing area to draw a shape. The shape is filled 

with the fill that you chose.
3 Right-click a color to select a new fill color from the Color palette.
4 Click the Match Fill Color icon .
5 Click the fill area of the shape that you drew. The shape is filled with the new color.

Lines and Fills
Select lines and fills from the Lines and Fills sections. Use No Line  to draw a fill area 
with no surrounding line. Select a Line , and choose a line width from the drop-down 
list. Use No Fill  when you do not want a fill within a closed line. Use a Solid Fill  
within any closed line (shape).

Freehand Draw
Use Freehand Draw  to draw a line that follows the movement of the pointer.

1 Select the desired line color from the Color Select panel.
To make an enclosed area, also choose a Fill color.

2 Click the Freehand Draw icon .
3 Select a line thickness option from the drop-down list in the Lines section.

Color Box

Color Palette

Theme
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4 Change the line smoothness if desired by clicking on the desired setting in the Smoothness 
Options box.

5 Click and drag across the work area from the desired start point to the desired end point to 
draw a line. A line appears showing the freehand line as it is drawn. 

6 Lift the pen or release the mouse button and the freehand line is completed.

Polygon Draw
Use Polygon Draw  to place points from which a line will be made. Polygon Draw is a 
good way to draw either a curved line, or one with straight sections. Hold down Ctrl while 
placing a point to make an angled section. The node will be displayed as a square, and 
that part of the line will be converted to nodes with no curves.

When Snap to Line is selected, if the mouse pointer is close to an existing line, the pointer 
will change to a diagonal bar .

Any points placed while the diagonal bar is displayed will move on top of the old line, and 
the new line will snap to the old one. When Snap to Grid  on the Draw tab is selected, 
any points placed with Polygon Draw will snap to the nearest grid line.

Joining Lines
You can join lines to any other line, or to themselves, using either Freehand Draw  or 
Polygon Draw .

Closed Lines
If a line is drawn close to its own starting point, then the mouse pointer 
will change to a cross . If that line is completed while the pointer is a 
cross, the line will be closed to form an area that may be filled.

In Freehand Draw, complete the line by releasing the mouse button. In Polygon 
Draw, right-click in the drawing area to complete the line.

Appending to a Line
When Freehand  or Polygon Draw  is selected, if the pointer is 
placed close to the end of an existing line, the pointer will change to a 
plus sign . If the line is completed while the pointer is a plus sign, then 
the new line will append itself to the original line, taking on its properties 
(that is, it will be the same color).

Drawing Shapes
Use Shapes  to draw shapes in the drawing. The shape will be drawn as a 
closed line, that may be filled. Select your shape from the drop-down list. 
Seventy-five different shapes are available.
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Hold the Ctrl key down when using Shapes  to keep the original proportions of the shape. For example, 
use Ctrl to draw a square rather than a rectangle, or a circle instead of an ellipse.
If Snap to Grid is used when drawing a shape, the shape will snap to the grid lines.

Draw a Shape
1 Select the desired line and fill colors and types.
2 Click the Shapes icon .
3 Select the type of shape you wish to draw from the drop-down list in the tool options box.
4 Click the option with an "x" in the center to draw a shape starting from the center, or the 

option with an "x" in the corner to draw a shape starting from the top left corner.
By default, shapes are drawn from the center.

5 Click and drag across the work area from the desired start point to the desired end 
point and the shape appears in the drawing area. 
The dimensions of the box are shown in the status bar. Lift the pen or release the 
mouse button and the shape appears.

6 If the shape needs to be moved, use either Box Select  or Freehand Select  to 
select the rectangle, and then move the rectangle to the desired position. 
Alternatively, click Undo  and draw the shape again.

MiniPics
Use MiniPics  to add any of the special small clipart pictures included with your 
PREMIER+™ 2 Embroidery System. An added MiniPic is automatically selected, ready to be 
moved or copied.

To see the name of a MiniPic, position the arrow pointer over the desired thumbnail.

Each MiniPic for the Draw Window is inserted as a group, so it can be separately selected later.

Text
Use Text  to add text to your picture in any TrueType® or Open Type® font available on 
your computer. Text is drawn using the selected line and fill colors. Choose from Regular, 
Bold, Italic or Bold Italic styles, and adjust the font size in points.

Add Text to Your Drawing
1 Select the desired colors for line and fill in the Color panel. Use Pick Line Color  or Pick Fill Color  

if you want to select colors from the picture.
2 Click the Text icon .
3 Click on the work area where you wish the lettering to start and the Create Text dialog box appears.
4 Click the drop-down arrow for the Font and select the desired TrueType® Font installed on your 

computer.
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5 Click the drop-down arrow for Style and choose Regular, Bold, Italic or Bold Italic.
6 Set the size in points by typing in a number, or click on the drop-down arrow and choose a point size.
7 Click in the Text box and the arrow cursor becomes an I-bar. Type the desired text. Press Enter to 

create a new line and type more text. When you have typed all the required text, click OK.
8 The text appears in a highlighted box to the right of where you clicked after selecting the Text 

icon .

9 Right-click to deselect the Text function. The selection box has handles to adjust it.
10 If desired, use the resize handles to make the text bigger or smaller. Hold down Ctrl to resize 

proportionally, and Shift to resize from the center. Use the rotate handle to rotate the text to any 
degree.

11 Click anywhere outside the box to deselect.
Use Encore and Multiply to automatically create copies of the text.

Editing Drawings
In the Draw window of PREMIER+™ 2 Create, all drawings are made up of lines or groups of 
lines (objects), and each line is defined by a series of points (nodes). You can select any 
individual line and change it by adjusting, adding or deleting nodes.

Node types vary according to their position in the line, and the 
form of the line.

When a line is first drawn in Freehand Draw, the end nodes are square. Those 
of a Polygon Draw line are round, unless Ctrl was used.
Round nodes indicate a curved line. The nodes at each end of a 
curved line are a circle within a circle, while those in the middle 
are an empty circle.

You can change a round node to a square node by holding down Ctrl and clicking the node. To change it 
back, release Ctrl, and click the node again.
Square nodes indicate a straight line with angled sections. The 
nodes at each end of an angled line are a square within a square, 
while those in the middle are empty squares. Start and end nodes 
are a circle within a circle, or a square within a square. The start node is green, and the end 
node is red.

Use Reverse Path to reverse the start and end points of the selected line.

Edit, Add and Delete Nodes
Use Edit Nodes  to change the position of the nodes on the currently selected line. 
Moving a round node affects the two sections of line to either side of that node. This 
ensures line smoothness. You can append one line to another by joining two end nodes. 
The line that is joined to will take on the characteristics of the line that does the joining. 
Use Delete Nodes  to remove the currently selected node. If a middle node is deleted, 
the line will be redrawn to follow the path between the nodes that are left. Use Add 
Nodes  to add a node to the currently selected line. Use Edit Line  to change the 
shape of the currently selected line.
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Use the Knife tool  to cut the currently selected line, shape or group (object) into two 
parts. One part is automatically selected.

Any filled shapes will be converted into lines when cut with the Knife.

Selecting Objects
When one of the editing tools is being used, the currently active line or area is surrounded 
by a box. If that box is selected, the line or area can be moved, resized, mirrored, rotated 
and skewed. The selection tools can also be used to select and manipulate several 
individual objects at once, or several objects forming a Group.

When an editing tool is in use, you can select more 
than one object by holding down Ctrl and clicking 
the desired objects in the FilmStrip.  When making 
a selection, only objects that are completely 
enclosed by the selection line will be included in 
the selection.
Right-click a block to change the properties of the 
lines and fills within it using the Object Properties 
dialog.
When a new selection is added to a design 
by paste or one of the insert functions, it is 
automatically selected as the current block and Box Select  is activated. Click the 
drawing area outside a block to deselect it. 

Right-click to deselect a block and also turn off the current select function.

Use Rotate 90º  to rotate all objects in a block around the Center of Rotation .
Use Delete  to delete a selected block of objects, or use the Delete key.

Select the line Draw the cut line Right-click to cut

Box Select Click and drag to draw a rectangle around the area you want to select. 

Freehand Select Click and drag to draw an irregular outline around the desired area.

Freehand Point Select Click a series of points to create an irregular outline of straight or 
curved lines around the desired area.

Select All Select all visible objects in the drawing with one click.

Replace Selection Replace the currently selected area with the new selection.

Add to Selection  Add the new selection to the currently selected area.

Remove from Selection Remove the new selection from the currently selected area.

Mirror Vertical Handle

Rotate
Handle

Resize
Handle

Skew
Handle

Mirror
Horizontal

Handle

Center of
Rotation
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Alignment Tools
The Alignment tools allow objects to be aligned precisely. Select the objects that you want 
to align, then use one of the alignment tools. Objects can be aligned horizontally or 
vertically. They can also be centered.

Align Left  aligns all selected objects with the left edge of the object furthest to the left. 
Align Center  centers all selected objects horizontally relative to each other. Align 
Right  aligns all selected objects with the right edge of the object furthest to the right. 
Distribute Horizontally  aligns all selected objects to be equally spaced horizontally.

Align Top  aligns all selected objects with the top edge of the highest object. Align 
Middle  centers all selected objects vertically relative to each other. Align Bottom  
aligns all selected objects with the bottom edge of the lowest object. Distribute 
Vertically  aligns all selected objects to be equally spaced vertically.

Use Center In Hoop  to move the selected objects to the center of the hoop.

Grouping and Ungrouping Selected Objects
Edit lines or areas individually, in a selected block, or in groups which can remain as a 
section after saving. You can also place groups in larger groups.

When a drawing is loaded using Insert, all sections will be grouped together.

Use Group  to make a group of all the currently selected objects. Either Group the 
objects permanently, or Group them temporarily while moving or editing them.

A group can be modified in the same way as a block.
Use Ungroup  in the Group drop-down menu to split the currently selected group into 
the objects which make it up. These may be lines, filled or unfilled areas, or smaller groups.

Ungroup can only be used when a group is selected.
Use Ungroup followed by Delete, then Group again to remove an unwanted section from a drawing.
Use Ungroup All  in the Group  drop-down menu to split all the groups within the 
selected group into their individual lines and areas.

Use Select All  and then Ungroup All to Ungroup whole drawings.

A MiniPic is a single Group When Ungrouped it is a block Move a part separately
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FilmStrip
Use the FilmStrip to view the structure of objects in your drawing. View 
your drawing structure by opening its groups. Examine and move the 
individual lines or fills (paths) and groups within those groups.
The FilmStrip shows the sequence of objects within the drawing. The 
currently selected object is highlighted in the FilmStrip, and objects can 
be selected directly in the FilmStrip. To select several objects that are 
next to each other, hold down the Shift key, and click the start and end 
object in the sequence. To select objects that are not next to each other, 
hold down the Ctrl key and click the desired objects.
Use Combine Paths  to combine the paths (lines) for the selected 
objects. This is usually to create a hole in the fill for a shape.
Use Uncombine Paths to break apart an object combined with Combine Paths.

Encore and Multiply
Use the Encore function  to place repeated copies of the selected 
drawing in a line across the drawing area. 
The number of copies is calculated 
automatically to fill the drawing area. The 
drawings are placed in a line from left to right 
and centered in the drawing area.
Use Multiply  to repeat drawings or edit actions automatically by reflecting across, 
down or rotating. All changes in the drawing, such as adding, editing, pasting and 
removing lines and groups are multiplied.
You can use the select tools, and Group and Ungroup, while Multiply is active.
Multiply will either reflect or rotate images. Existing objects will not be affected, even if 
they are edited, but the selected objects or any new object that is either drawn or pasted 
in will be reflected or rotated.
You cannot append lines while in Multiply mode.
Choose the Reflect and Rotate options provided to repeat actions. The previews in the 
drawing area show how actions will be repeated according to the current selection. Click 
Multiply  on the Draw tab to turn Multiply on and off. The blue Multiply reflection lines 
are shown on the drawing area when setting up Multiply and when it is switched on.

Use Reflect 8-Way to create eight copies. 
Additional blue lines show the eight segments.

Use Rotate 8-Way to create eight rotated copies 
around the Multiply center point. Additional blue 
lines show the eight segments.
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7Motifs, Machine Stitches and 
Stamps

Using Motifs
A motif is a small element designed so that it will repeat along a line or along multiple 
lines to fill an area. Choose any available motif for motif lines, tapered motifs columns and 
fill areas. All the system motifs are in the Universal Group. Use My Motifs for motifs that 
you create.

Create and modify motifs, and machine stitches for certain machines, using the functions 
in the Draw window.

Use Import Motif  to open an existing 
motif to modify it, or to create a stitch for 
certain sewing machines.

Use the motif viewer to browse thumbnails 
of motifs before opening them. Choose a 
Group and a Category to view, then load a 
motif. To see the motif number, position the 
arrow pointer over the desired thumbnail.

Use Export to My Motifs  to save the 
design or selected area on the screen to the 
My Motifs database. There is no confirmation of this action.

Only the motif design is saved, not the color.
Use Manage My Motifs  to delete unwanted My 
Motifs.

To remove an unwanted My Motif, select the desired 
motif then click Delete. A message will appear to ask 
for confirmation. Click OK to remove the motif.

To backup up My Motifs, use the Backup MySettings 
feature in PREMIER+™ 2 Configure.

Creating Motifs
Any drawing can be made into a motif, but for best 
results use a simple design with start and end points to 
the left and right. To save the design or selected area 
on the screen as a motif, use Export to My Motifs .

To make a permanent copy of the motifs you create, use Save As Drawing  to save the design as a .4qb 
design file. This will save the precise position of the nodes that you used, and whether they were for curves 
or corners.
Create motifs manually, or by tracing an existing design loaded as a background picture.
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When reloading a partially complete drawing to finish creating a motif, use the Open Background Picture 
feature on the File menu of the Draw window to reload the background.

Create a Motif
1 In the Draw window, select Polygon Draw .
2 Place points, using the Ctrl key to create corner or square points, to draw the 

outline of a tree from left to right. Right-click to finish the line.
Start and finish on the same horizontal line.
The start and end stitches should always be aligned horizontally, with the start 
stitch on the left and the end stitch on the right.

3 Click Save As Drawing  and save the motif design as Tree Outline.4qb.
4 Ensure that the tree outline is selected.
5 Click My Motifs, Export to My Motifs .
6 If the first and last stitches are not aligned horizontally, a message appears to give you the option to 

rotate the motif or add an alignment stitch.Click the desired option and then export the motif to the 
My Motifs database.

Design Notes
Motifs should be designed at the size they are most likely to be used, as this will match the 
detail in the motif to the scale at which it is used. If you are likely to use the same motif at 
different sizes, where one size is at least twice as big as the other, make two versions of the 
motif. Decreasing the size of a motif will create too much detail, and increasing the size of 
a motif will give an apparent loss of detail and smoothness.

Motifs are generally used as a chain of motifs in a motif fill area or a motif line. They should 
be designed from left to right, so that when they are used they are connected in sequence 
at the start and end points.

Corner (square) nodes will always be stitched. Curved (round) nodes indicate the line to be 
used, but the program will calculate the number of points (stitches) required to make the 
curve.

Always test your motifs on scrap pieces of the fabric you are going to use. Always use 
stabilizer to help prevent pull on the fabric.

You can only make a motif from an image that is entirely connected. If there is no direct 
connection between parts of the design, they cannot be exported as a motif. Add 
connecting lines to the design in the design area before using Export to My Motifs. 
Alternatively, delete any unconnected details, leaving an outline.

Add lines that lead in and lead out of your design before exporting.

To ensure that the motif is created to line up correctly, use the grid.
The example shows how you might use lead-in 
and lead-out lines; they have been added to 
give the illusion that the car is sitting on the 
road.

Notice that the lead-in and lead-out lines are 
the furthest left and furthest right parts of the 
design.



PREMIER+™ 2 Create   Motifs, Machine Stitches and Stamps              55

Simplifying the Design
There may be too much detail in a design. Use Edit Nodes  and Delete Nodes  to 
remove extra details, and smooth outlines.

Use Edit Nodes  to change the position of the nodes on the currently selected line. Moving a round node 
affects the two sections of line to either side of that node. This ensures line smoothness. You can append 
one line to another by joining two end nodes. The line that is joined to will take on the characteristics of the 
line that does the joining.

Use Delete Nodes  to remove the currently selected node. If a middle node is deleted, the line will be 

redrawn to follow the path between the nodes that are left. Use Add Nodes  to add a node to the 

currently selected line. Use Edit Line  to change the shape of the currently selected line.

Using Your Motifs
The motif that you created will be in the My Motifs Category in Manage My Motifs and in 
the Fill Area and Line Properties for any type of motif line or fill.

Use a Motif that you Created
1 Select a line or fill area using Motif Line , Motif Fill , Tapered Motifs , Shape Fill , 

MultiWave Fill  or Curved Crosshatch Fill .
2 Right-click the object to open the Fill Area and Line Properties.
3 In the Group drop-down list select My Motifs. The My Motifs Category is selected automatically.
4 From the Pattern drop-down list select the desired motif.
5 Use Height and Width to set the size of your chosen motif.

When checking a new motif in Fill Area and Line properties, increase the Vertical Gap to see the individual 
rows of the motif.

6 Click OK to place the motif in your line or fill.

Machine Stitches
Use Import Machine Stitch  to open an existing stitch to modify it, or to export it as a 
motif. PREMIER+™ 2 Create displays the Open dialog box so you can choose a machine 
stitch design file to open. 9mm, Maxi and Spx files may be loaded.

Use Export as Machine Stitch  to save the 
drawing or selected area as an .spx machine stitch 
for certain sewing machines, or send it to the 
sewing machine. Save and name the design file. 
PREMIER+™ 2 Create displays the Export as 
Machine Stitch dialog.

Define a maximum length for the stitch.

Click Export As Machine Stitch  to export the 
stitch. The Save As dialog for machine stitches is 
displayed so you can name your stitch. Files can 
be saved in Spx (.spx) format.

Use Send to Machine  to send a saved Spx 
stitch file to your connected machine.

Alternatively, copy the Spx stitch file to a USB Embroidery Stick.
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Creating Stamps
Stamps are used in PREMIER+™ 2 Modify to emboss areas of fill and satin. Create your own stamps from 
drawings, saving them as .4qb files. See “Creating a Drawing” on page 45.
Any drawing can be made into a stamp, but for best results use a simple design. If the 
stamp will be used for a fill, rather than singly or in a line, ensure that there is plenty of 
space around the design, so designs do not merge.

Use Save As Drawing  to save the stamp design as a .4qb file. This saves the precise 
position of the nodes that you used in your drawing, and whether they were for curves or 
corners.

Save stamps to your My Pictures folder, or create a Stamps folder in your My Designs folder.
Create stamp designs manually, or by tracing an existing design loaded as a background 
picture.

When reloading a partially complete drawing to finish creating a stamp, use the Open Background Picture 
feature on the File menu of the Draw window to reload the background.

Design Size
Stamps should be designed at the size they are most likely to be used, as this will match 
the detail in the stamp to the scale at which it is used. If you are likely to use the same 
stamp at different sizes, where one size is at least twice as big as the other, make two 
versions of the stamp. Decreasing the size of a stamp will create too much detail, and 
increasing the size of a stamp will give an apparent loss of detail.

Always use your stamps in a test stitchout before using them in a project.

Simplifying the Design
There may be too much detail in a design. Use Edit Nodes  and Delete Nodes  to 
remove extra details, and smooth outlines. 

Use Add Nodes  to add extra detail to a stamp to be used at a larger size.

Use Edit Nodes  to change the position of the nodes on the currently selected line. Moving a round node 
affects the two sections of line to either side of that node. This ensures line smoothness. You can append 
one line to another by joining two end nodes. The line that is joined to will take on the characteristics of the 
line that does the joining.

Use Delete Nodes  to remove the currently selected node. If a middle node is deleted, the line will be 

redrawn to follow the path between the nodes that are left. Use Add Nodes  to add a node to the 

currently selected line. Use Edit Line  to change the shape of the currently selected line.

Using Your Stamps
Use your stamps from the Emboss tab of PREMIER+™ 2 Modify. Set the size and angle of 
the stamp, then select a single stamp, a stamp line, or a stamp fill.
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Make an Anchor Stamp from a Picture
1 Click File, New  or File, New Window  and the Choose Design Type page of the ExpressDesign 

Wizard will appear.
2 Click Load a Vector Picture as Objects into the Draw Window , then click Next.
3 Click Load a Picture  and in the Picture Viewer, browse to 

Documents\Premier+2\Samples\Create\Pics2\Anchor.4qb and click OK to load it onto the Choose 
Picture page. Click Next.

4 In the Design Size page click 
Finish to close the wizard.

5 In the Quick Access toolbar, 
click Change Hoop  and 
in the Hoop Selection 
dialog box set the Hoop to 
100mm x 100mm - 
Universal Square Hoop 1. 
Click OK.
A small hoop is best for 
designing at this scale.

6 In the FilmStrip on the left 
of the screen, double-click 
the Group Insert entries to 
open the structure of the 
drawing.

7 In the FilmStrip, click the 
waves behind the anchor to 
select them.

8 Click Delete .
9 Between the circles and the anchor in the FilmStrip is the fill for the anchor. Select this fill area which 

appears transparent in the FilmStrip and click Delete .
There are now two items in the design, the anchor and the circle around it.

10 Click File, Save As Drawing , and browse to the folder Documents\Premier+2\My Pictures.
11 Save the edited picture as Anchor Stamp.4qb.

Alternatively, create a Stamps subfolder within this folder.
12 In the QuickLink toolbar at the bottom of the screen, click PREMIER+™ 2 Modify.
13 Open an embroidery with large areas of fill or satin, for example 

Documents\Premier+2\Samples\Create\Stitch\Diamond.
14 Click the Emboss tab.
15 Click Load Stamp File , and in the viewer load the file Documents\Premier+2\My 

Pictures\Anchor Stamp.4qb.
16 Click Single Stamp . The pointer changes to an anchor. Stamp one of the green 

areas of the diamond. A large single stamp appears in the diamond fill area.
17 Click Undo  to remove this stamp.
18 Click Stamp Fill . The complete area of the diamond is stamped with 

the anchor design.
19 Click Undo  and vary the size and angle of the stamp before stamping 

again.
Try browsing to Documents\Premier+2\Samples\Create \Pics2\ and using 
other .4qb pictures in this folder as stamps. Some work well, but others are too 
detailed. 
You can also use Load a Background Picture into the Draw Window in the 
ExpressDesign Wizard to load a bitmap graphic or a photo to draw a design 
over.
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8Creating a Painting
A full range of painting functions is available for raster graphics files (created using a grid 
of pixels, and less easily resizable than vectors). In addition to the standard features, 
PREMIER+™ 2 Create includes a MiniPics function for adding special small clipart, and a 
range of Image Effects for improving pictures ready for creating designs.

Use the Paint tab to select and edit your picture.

Use the Paint window control panel to select colors, and paint lines and fill areas.

Painting Tools
Use the Paintbrush  to paint lines on the picture that follow the movement of 
the pointer. Select a round or square brush in one of five different widths.

Use Line  to draw straight lines with round or square ends in the picture using 
one of five different widths.

Use Calligraphy  to paint lines on the picture. Select from two different pen angles and 
four different line widths.

Use Shapes  to draw shapes in the design. The shape will be drawn as a closed line, that 
may be filled. Select your shape from the drop-down list. Seventy-five different shapes are 
available. Hold the Ctrl key down when using Shapes to keep the original proportions.

Use Flood Fill  to fill an area of the picture with the foreground or background color. The 
pointer changes to the paint bucket . The area to be filled is defined by other colors 

Resize, crop, and fill the background to the picture

Show the GridCut, copy, paste or delete an area of the picture
Use a selection tool to choose part or all of the picture

Improve the picture brightness, color, sharpness and definition

Rotate or mirror part or all of the picture

Pick a color from the palette

Pick foreground color

Pick background color

Choose a color theme

View and swap the foreground and background colors

Add a line, shape or clipart to your picture

Flood fill areas of the picture

Paint with brush or pen
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surrounding it or the edges of the work area. Left-click to fill an area using the foreground 
color, or right-click to use the background color. 

MiniPics
Use MiniPics  to add any of the special small clipart pictures included with your 
PREMIER+™ 2 Embroidery System. An added MiniPic is automatically selected at the top 
left of the work area, ready to be moved or copied.

To move a MiniPic you must click in a colored (non-background) area.

Editing Paintings
Use one of the selection tools: Box Select , Freehand Select , Freehand Point 
Select , Ellipse Select , or Magic Wand Select  to select part of the picture as a 
block. After selection, delete, cut, copy, resize, rotate or mirror the block. Crop the picture 
so that only the selected area remains. Apply effects to adjust only the selected area. 

If desired, use Exclude Background  to include or exclude areas matching the background color.

To resize the block, click and drag one of the corner 
resize handles as desired. Hold down Ctrl as you click 
and drag to resize proportionally. Hold down Shift to 
resize from the center. Rotate the selection around 
the center of rotation to any degree with the rotate 
handle. Click and drag inside the selection to move it 
to a new position in the picture.

To deselect the area, click anywhere in the work area 
outside the selection box.

Select and Resize Areas
Use Box Select  to select an area of the picture by drawing a rectangular box around it. 
Use Freehand Select  to select an area of the picture by drawing a freehand line around 
it. Use Freehand Point Select  to select an area of the picture of any shape, defined by a 
series of points. Select All  is a one click function that selects all of the picture.

Use Ellipse Select  to select an area of the picture by drawing a circle or ellipse with a 
rectangular selection box around it. Click and drag around the area that you want to select 
with the ellipse select pointer .

The Magic Wand  selects an area of similar color to where you clicked. The color, hue 
and brightness are used when making this selection. Click Magic Wand Select and the 
pointer changes to the magic wand pointer . Use the Tolerance settings to set the color 
variation for the Magic Wand selection.

When Invert Selection  is clicked all the currently selected areas become deselected, 
and the deselected areas become selected. 

Use Replace Selection  to replace the currently selected area with the new selection, use Add to 

Selection  to add the new selection to the currently selected area, and use Remove from Selection  to 
remove the new selection from the currently selected area.

Resize
Handle

Rotate
Handle

Selection
Box

Center of Rotation
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Resize Part of a Picture
When part of the picture has been selected with one of the selection tools, click and drag 
one of the corner resize handles to change the size of the area. When the pointer is over a 
resize handle the pointer changes to a double-headed arrow pointer . Hold the Ctrl key 
down when resizing to keep the proportions the same. Hold the Shift key down to resize 
from the center.

Resize
Use Resize  to increase or decrease the 
size of the whole picture. The Resize dialog 
box appears so you can enter a new size.
The Resize function only resizes the whole picture, it 
does nothing if only part of the picture is selected.

Crop
Use Crop  to decrease the size of the picture by removing the parts that are not wanted. 
Use one of the selection tools, e.g. Box Select  or Freehand Select , to select the area 
of the picture that you wish to keep, then click the Crop icon . The parts of the picture 
outside the selection box are removed and the display adjusts to show the remaining part 
of the picture at the largest possible magnification.

If you are going to use a picture in the ExpressDesign Wizard, it is recommended to use the Rotate and Crop 
Picture page of the ExpressDesign Wizard to select the desired section of the picture.

Crop only removes rectangular areas of the picture, so the results will be the same with Box Select  or 

Freehand Select .

Rotate Part or All of the Picture
Use Rotate  to rotate the whole picture by any 
degree. The Rotate dialog box appears so you can enter 
the rotation angle. The background color from the Color 
box is used for the background against which the 
picture is rotated. If desired, change the background 
color before rotating.

The Rotate function only rotates the whole picture. If part of the 
picture has been selected, use the rotate handle to rotate the 
selection. To rotate part or all of the picture by exactly 90 degrees, 
use Rotate 90 . When an area is chosen with one of the 
selection tools, only the area that was selected is rotated, even if the selection box appears rectangular.
Use Mirror Horizontally  to mirror the selected part or all of the picture from side to side, 
and use Mirror Vertically  mirror the selected part or all of the picture from end to end.
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9Getting Started with 
PREMIER+™ 2 Sketch
Welcome to PREMIER+™ 2 Sketch. PREMIER+™ 2 Sketch allows you "draw" your own stitch 
paintings. Use the Standard freehand or straight line tools to create perfectly regulated 
Running and Triple Stitch Lines or Satin Lines. Draw your favorite machine stitches with 
Motif Line. Use the Free motion features to add highlights and texture to your pictures and 
designs. The stitching changes according to your drawing speed, just like traditional free 
motion embroidery. Enhance your creations with zigzag stitching in a horizontal or 
rotational path — you may even taper the width as you draw. Embroider your signature or 
use the Calligraphy feature to create beautiful monograms.

Use the Load Design Wizard to open a picture into the desired hoop. Then draw highlight 
stitches over the picture, print the picture, either directly onto fabric or using iron-on 
transfer paper, and stitch the highlights directly over the picture. Save the picture and 
embroidery together in .vp4 format ready for further work, or to export and stitch out.

Starting PREMIER+™ 2 Sketch
 In PREMIER+™ 2 Embroidery , click the PREMIER+™ 2 Sketch icon  on the QuickLink 

toolbar. PREMIER+™ 2 Sketch will start.

Parts of the Software Window

Stitches are drawn in the chosen colors. The background color can be changed using 
PREMIER+™ 2 Configure.

Title Bar Menu Bar Toolbar

Status Bar Work Area Control Panel
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The position of the last stitch in the embroidery is shown as a cross . If desired, the cross 
can be hidden using an option in Screen Preferences .

To the right of the work area is the control panel, which is split into two pages. Click the 
tab at the top of the control panel to access the desired page. The Color Select area is 
common to both pages. Change and hide colors. Edit and add notes in the Notes and 
Settings boxes.

Use the Standard page to draw perfectly regulated running, triple, motif and satin lines in 
freehand (curved) or straight lines. Also adjust their stitch type options before drawing.

Use the Free page to draw free motion, zigzag and calligraphy stitches. Change the stitch 
speed, zigzag width, and calligraphy angle.

Sample Files
Samples are included that are shown in the ’How-To’ examples and tutorials. The sample 
files will be installed to subfolders of Documents\Premier+2\Samples\Sketch or the folder 
of your choice. 

PREMIER+™ 2 Sketch Terms and Conventions
On-screen pointers
The Box Select pointer , Freehand Select pointer  or Freehand Point Select 
pointer  appears when the associated Select function is chosen. When Erase 
Stitches  is chosen, the eraser pointer  appears.

If Pick Color  is chosen, the eyedropper pointer  appears. This is also used when 
loading a picture with the Load Design Wizard, to choose the first thread color for drawing 
stitches.

In the Load Design Wizard on the Crop Picture page, the pointer becomes a double-
headed arrow  when you move the crop lines or a four-headed arrow  when you 
move the crop area. On the Alignment Stitches page, the pointer is a cross-hair  where 
you can add alignment stitches.

On the Free Motion page of the control panel, the Single Stitch pointer , the Free 
Motion pointer , the Horizontal Zigzag pointer , the Rotational Zigzag pointer , 
or the Calligraphy pointer  appears when the associated Free Motion function is 
selected.

On the Standard page of the control panel, the Running Stitch pointer , the Triple 
Stitch pointer , the Motif Line pointer , the numbered 2mm, 4mm or 6mm Satin 
Line pointer , or the Custom Satin Line pointer  appears when the associated 
function is selected.
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10Load Design Wizard
Use the Load Design Wizard to start a new embroidery by loading a picture you wish to 
embellish or start a new embroidery without following a picture. Also use the Load Design 
Wizard to load an existing embroidery you wish to modify.

Load Design Wizard Pages
Load Design Wizard — Design Options

Choose a project type: use a picture, load a .vp4 embroidery created in PREMIER+™ 2 
Sketch, or start with an empty work area.

Use this option to load a saved .vp3 embroidery and its associated picture. Load the picture, then Insert the 
embroidery in the work area. Check the Notes to ensure that you set the hoop and picture size correctly.

Load Design Wizard — Hoop Size

Select a hoop, and the color of the first thread when using an empty work area.

Start a project with a picture

Load a .vp4 embroidery created

Start a project with no picture

in Sketch

Preview the hoop size

Select a hoop and orientation

Choose the first thread color
for an empty work area
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Load Design Wizard — Choose Picture

Load Design Wizard — Rotate and Crop Picture

Load Design Wizard — Picture Size

Select a picture file on
your computer

Paste a copied picture

Import a file from a
scanner or camera

The picture is previewed

Load a picture from Facebook®, 
Instagram®, Flickr®, or Twitter®

Change the angle of the picture

Zoom in and out

Select the whole picture

Use the default crop settings

Adjust the crop lines as desired

Zoom in and out

Set the height of the picture

Select the initial thread color
for a new embroidery
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Load Design Wizard — Add Alignment Stitches

Use the Add Alignment Stitches page to add stitches at the beginning of the embroidery 
that you can use to align the picture with the embroidery.

Place Crosses on Picture
Move the pointer over the picture and the pointer will be a cross  where you may place 
alignment stitches. Click to place alignment stitches, which are shown as blue crosses. 

Automatic Corners
Choose this option to automatically place alignment stitches that are aligned with all four 
corners of the picture.

None
Choose this option if you do not wish to add alignment stitches.

Load Design Wizard — Load Embroidery

Use the Load Embroidery page to load a .vp4 embroidery, with its hoop and background 
picture.

Zoom in and out

Select an alignment stitch style

Remove stitches and start again

Zoom in and out

View and load embroideries

Paste from the clipboard

Preview a copied embroidery

Embroidery information
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11Drawing Stitches

Insert Mode
Use Insert Mode to determine if all stitches and color changes are added at the end of the 
embroidery, or if they can be inserted at any point in the embroidery.

Insert Mode Off
When Insert Mode is off , its icon is blue. Stitches and color changes are always added 
at the end of the embroidery. This also applies when pasting a block of stitches, and for 
opening embroideries directly onto the work area. Also, when any of these functions are 
used, any stitch point that is selected will be automatically deselected.

The last stitch in the embroidery is marked with a cross . The last stitch marker can be 
turned off in Screen Preferences .

Insert Mode is always off when PREMIER+™ 2 Sketch is started.

Insert Mode On
When Insert Mode is on , its icon is highlighted (orange). 

Stitches, color changes and stop commands are 
inserted at the selected stitch point. If no stitch point is 
selected, stitches, color changes and stop commands 
are added to the end of the embroidery, as when Insert 
Mode is off. The insert point is also used when pasting 
a block of stitches, and for opening embroideries 
directly onto the work area. If an insert point is 
selected, a small box is shown around the chosen 
stitch point.

If Insert Mode is on, the stitch point can be deselected by right-clicking anywhere on the 
work area.

Stitch Drawing
Use the pen on a graphics tablet to draw stitches with any of the stitch drawing functions 
in the Standard or Free pages of the control panel:

Standard Page

Running Stitch Triple Stitch Motif Line Satin Line 

Drag the pen across 
the tablet to draw a 
line of running stitch

Drag the pen across the 
tablet to draw a line of 
triple stitch

Drag the pen across 
the tablet to draw a 
line of motifs

Drag the pen across 
the tablet to draw a 
satin line
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Free Page

Draw stitches on the work area using the pen on a graphics tablet (or with click-and-drag 
with the mouse).

When drawing Free Motion, Horizontal ZigZag, Rotational ZigZag and Calligraphy, stitches 
are added continuously while the pen is in contact with the tablet (or until the mouse 
button is released). Move the pen faster to add stitch points further apart, or slower to add 
stitch points close together. 

Trims  and tie-offs are added automatically at the end of each section. Use Stitches 
Preferences  to change the settings for tie-offs, and the minimum gap for trims. Insert 
Stop Commands  to allow appliqué or decoration to be added.

Standard Mode

Single Stitch Free Motion Horizontal Zigzag 

Add one stitch each time the 
pen is touched to a graphics 
tablet

Drag the pen across the tablet 
to continuously draw stitches

Drag the pen across the 
tablet to continuously draw 
zigzags from left to right

Rotational Zigzag Calligraphy 

Drag the pen across the tablet to 
continuously draw zigzags at 
right angles to the pointer path

Draw stitches on the work area 
using the pen on the tablet (or 
with click-and-drag with the 
mouse)

Change a thread color

Choose a fixed width Satin Line

View the Clipboard contents

Set the properties for the line
Draw a Running Stitch line

Draw a Triple Stitch line
Draw a Motif Line

Draw a custom Satin Line

Read the Notes & Settings
Edit the Notes & Settings text

Draw a straight line
Draw a curved line

Display all stitches

Set the custom line properties

View or hide a thread color

Select the Overview window

Change thread range & colors
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Adjust the stitch type Options for Standard stitch lines before drawing.

Standard Mode stitch types are not affected by the Free Motion Stitch Speed. Also, the speed that you move 
the pen (or mouse) has no effect.

Freehand or Straight
Use Freehand  to draw a curved or freehand stitch line on the work area. The stitch line 
follows the curves of the line that you drew.

Use Straight Line  to draw a straight stitch line on the work area. The stitch line uses a 
direct route between the place that you started drawing, and the place where you lifted 
the pen (or released the mouse button).

Line Type
Add as many sections of a line type as desired. A Trim  is automatically inserted at the end of each 
section. Right-click to deselect the function, or simply select another tool.
Use Running Stitch  to draw stitches at regular intervals using a preset stitch length.  
Stitches are only added while the pen is in contact with the tablet (or while the mouse 
button is held down).

Each new stitch point is added when the distance reaches the preset stitch length from the last stitch point. 
Use Triple Stitch  to draw lines of three-part stitches, each composed of one stitch 
going forward, one going backward then one going forward, using a preset stitch length. 
Stitches are only added while the pen is in contact with the tablet (or while the mouse 
button is held down).

Each new stitch point is added when the distance reaches the preset stitch length from the last stitch point.
Use Motif Line  to draw motifs according to the settings in the Motif Line properties 
dialog box. A whole motif is added when the pointer reaches a preset distance, according 
to the Width of the motif. To follow the line exactly, use Fit To Line. To draw a single motif, 
draw a line until one motif appears, and then stop (lift the pen or release the mouse 
button).

Use the Satin Line options to draw a line of constant-width satin stitch. Use the preset 
widths: 2mm Satin Line , 4mm Satin Line ,or 6mm Satin Line . Alternatively, use a 
Custom Satin Line , and set its properties in the Satin Line options dialog box. 

Satin Line is not affected by the Free Motion Stitch Speed. Also, the speed that you move the pen (or mouse) 
has no effect.
Stitches are only added while the pen is in contact with the tablet (or while the mouse 
button is held down).

2mm Satin Line has no Underlay, 4mm and 6mm Satin Line do have Underlay. To create lines of these 
widths with different properties, use a Custom Satin Line.

Create a Satin Line Road for a Cat
1 Click New  and in the Design Options page of the Load Design Wizard select Load Sketch 

Embroidery, then click Next.
2 Click the Open Embroidery icon  and in the Open dialog box load the embroidery 

Documents\Premier+2\Samples \Sketch\Stitch\Driving Cat.
3 Click Finish to load the embroidery onto the work area.
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4 Click Hoop , and in the Hoop Selection dialog box, select 260mm x 200mm - Universal Large Hoop 
3 and set Orientation to Rotated. Click OK.
This hoop will give more space for the satin line road than the hoop loaded with the embroidery.

5 Click the Standard tab.
6 Click Straight Line .
7 Click 4mm Satin Line .
8 Click and drag to draw a line parallel with the car’s tires, starting to the right of the car.

Lines show where the straight satin line will be placed.
9 Release the mouse button, or lift the pen, to complete the line.
10 Draw two shorter lines above to the left to create the other side of the road.

Stop Commands
Use Add Stop  to add a Stop command that is used to tell the embroidery machine to 
stop without a color change. This allows appliqué or a decoration to be added. 

To visualize appliqué fabric or decorations, use PREMIER+™ 2 Embroidery Extra.
Zoom in to the thread where you want to place the Stop, and in 2D Mode, select the stitch. 
A box appears around the stitch. Click Add Stop , and a Stop command marker appears 
at that point. If no stitch is selected, the Stop command is placed at the end of all the 
stitches. The Stop command is represented by a small red circle with an S .

Stop commands are only visible in 2D view. Switch between 2D and 3D view using the 3D  icon.

To delete a Stop command, select the stitch point associated with the Stop then touch the 
Delete key or click the Delete  icon.
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Free Motion Mode

Free Motion Stitch Speed
The Free Motion Stitch Speed controls the rate at which stitch points are drawn by Free 
Motion, Horizontal ZigZag, Rotational ZigZag and Calligraphy. It is equivalent to stitches-
per-minute on a sewing machine. The Free Motion Stitch Speed can vary from 100 to 2000 
stitches per minute, in steps of 100.

When initially using PREMIER+™ 2 Sketch, the Free Motion Stitch Speed is fixed at the rate 
selected on the control panel. In order to change the speed, you must stop drawing 
stitches and adjust the slider. Drag the Free Motion Stitch Speed slider to set the desired 
speed. Alternatively, you may vary the Free Motion Stitch Speed while drawing stitches. To 
enable this, select the Allow Variable Stitch Speed option in Stitches Preferences . 

You can then change the stitch speed using:

• pressure sensitivity of the pen on a graphics tablet
• the A and S keys on the keyboard when using a mouse to draw stitches.
If you use the pressure sensitivity of the pen on a graphics tablet, the Free Motion Stitch 
Speed will be slow when you press lightly and fast when you press hard. You will see the 
slider moving as you change the pressure. This is equivalent to pressing a sewing 
machine’s foot control lighter and harder to make the machine go slower and faster.

Pausing the pointer in the same place for too long while drawing Free Motion, Horizontal ZigZag, 
Rotational ZigZag or Calligraphy will 'pile up' stitches. If you need to stop, lift the pen from the tablet.

Change a thread color

Set the speed of stitching

View the Clipboard contents

Place Single Stitches

Draw a Free Motion line

Read the Notes & Settings
Edit the Notes & Settings text

Draw a Calligraphy line

Draw a Rotational Zigzag line

Display all stitches

Set the Calligraphy stitch angle

View or hide a thread color

Select the Overview window

Change colors & thread range

Draw a Horizontal Zigzag line

Set the Zigzag line width
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Free Motion Stitch Speed and Zoom Level
When you are zoomed in, the distance you draw, as shown on the screen, is a shorter real 
distance in the embroidery, so the stitch points will be closer together. If you wish to keep 
the same appearance as stitches you have already placed, either move the pen faster or 
reduce the Free Motion Stitch Speed. The opposite happens when you zoom out. The 
distance you draw on the screen becomes a longer real distance in the embroidery, so the 
stitch points will be further apart.

Single Stitch and the Standard Mode stitches are not affected by the zoom level.

ZigZag Width
Use the ZigZag Width to set the width of Horizontal ZigZag, Rotational ZigZag and 
Calligraphy. Enter the desired width directly in the box, or use the up and down buttons to 
change the width. The minimum and maximum width is set in Stitches Preferences . 

Use Z (narrower) and X (wider) while drawing zigzag stitches to dynamically change the 
zigzag width. Tap to change the width by 0.1mm. Hold the key to change continuously.

When the ZigZag Width is set to a very low value the stitch points may be placed so close together that the 
3D view does not display the stitches correctly. Use 2D view to verify your stitches.

Calligraphy Angle
Use the Calligraphy Angle to set the stitch angle for drawing Calligraphy . Enter the 
desired angle directly in the box before selecting Calligraphy, or use the up and down 
buttons. Use Q (counter-clockwise) and W (clockwise) while drawing Calligraphy to 
dynamically change the angle.

Single Stitch
Use Single Stitch  to add one stitch at a time each time the pen is touched to the tablet 
(or with each left-click of the mouse). Alternatively, drag the pen across the tablet to pull 
out a line, then the single stitch point will be added at the point where the pen is lifted 
from the tablet. Right-click to deselect the function, or simply select another tool.

Free Motion Stitch Types
Add as many sections of free motion stitching as desired. A Trim  will be added at the end of a section. 
Right-click to deselect the function, or simply select another tool.
Use Free Motion  to freely draw stitches, placing stitch points at the Free Motion Stitch 
Speed shown on the control panel. Free Motion stitches can be drawn using any number 
of techniques, for example: 

• Move the pen at a steady rate to emulate normal free motion embroidery, for drawing 
lines and outlining areas. 

• Use fast scribbling actions to fill areas with color and for shading effects. 
• Use small circular or spiral motions for lace effects, or for filling in leaves on trees. 

For Felting Needle embroidery, increase the Free Motion Stitch Speed to increase the number of stitch 
points placed.
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Zigzag Stitches
For zigzag stitch types, stitches are drawn at the rate shown by the Free Motion Stitch 
Speed, at the current ZigZag Width. The stitch points are placed alternately on each side 
as you draw along the center of the zigzag.

Use Horizontal ZigZag  to draw stitches in a zigzag, 
horizontally to the left and right on the work area. Draw straight 
down to make a straight column of zigzag stitches. Move from 
side to side to skew the column to the left or right. Use the side-
to-side motion to create horizon stitches.

Use Rotational ZigZag  to draw stitches in a zigzag, at 90 
degrees to the direction the pointer is moving. Draw in any 
direction to make a curving path of zigzag stitches. Add as many 
sections of zigzag stitching as desired. 

Use Calligraphy  to draw calligraphic text and designs. The 
stitches are drawn in a zigzag, at the selected Calligraphy Angle.  
This picture shows how stitches will be drawn when the 
Calligraphy Angle is set to 45 degrees.

Any instruction book on using a pen for calligraphy can be followed for 
creating calligraphy in PREMIER+™ 2 Sketch. Simply draw with stitches instead of ink. Also, see the pictures 
in Documents\Premier+2\Samples \Sketch\PicsCalligraphy.

Create your lettering freehand if you are good at calligraphy, or trace over some lettering you prepared on 
paper and scanned, or prepared on the computer screen.

Create Lettering with Calligraphy
1 Click New  and in the Design Options page of the Load Design Wizard 

either select Load Picture for a New Embroidery to use some lettering as 
background, or select Start a New Embroidery with no Picture if you will 
work freehand. Then click Next.

2 Select a hoop. Click Finish, or click Next to load a picture, and then 
complete the wizard.

3 Click the Free tab, and then click Calligraphy .
4 Set the ZigZag Width to the width of the lines in your letters.

In the example a width of 2mm is used.
5 Set the Calligraphy Angle to suit the 

letters used.
In the example the angle is set to 45 
degrees.

6 Draw the first letter in your text. Try to 
use a single pen stroke.

7 Lift the pen, or release the mouse 
button. 
This is a test letter. Click Undo  if it was 
unsatisfactory. 
Lift the pen, or release the mouse button, 
to create an Undo point.

8 Move the slider to set the Free Motion 
Stitch Speed to a comfortable pace. 
Drag it to the right to draw more stitches, and to the left to draw fewer stitches. 
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Zooming in will enable you to work more slowly, and may give more precision.
9 Draw another letter and make any further adjustments to the speed, or the line width and angle.
10 Draw the other letters in your text. Lift the pen or release the mouse button at the end of each stroke.

Stitch Drawing Examples
Draw Free Motion and Zigzag Stitches on the Party Doll Dress

1 Click New  and in the Design Options page of the Load Design Wizard click Next to accept the 
default choice of Load Picture for a New Embroidery. 

2 In the Hoop Size page select 150mm x 150mm - Universal Square Hoop 2, then click Next.
3 In the Choose Picture page load Documents\Premier+2\Samples\Sketch\Pics\PartyDressDoll.png, 

then click Next and in the Rotate and Crop Picture page click Select All.
4 In the Picture Size page, change the thread color to the dark pink used for the semicircles around the 

bell of the dress (Sulky Rayon 40 1033 - Dark Orchid).
5 In the Add Alignment Stitches page place one cross alignment stitch at the tip of the finger on the 

left, and one at the tip of the shoe on the right. Then click Finish.
6 Click Preferences . Click the Stitches tab and ensure Allow Variable Stitch Speed is deselected 

(unchecked). For ZigZag Width, ensure the Minimum is set to 0.1mm and the Maximum is set to 
9.0mm. Click OK.
These are the default Minimum and Maximum settings for PREMIER+™ 2 Sketch, and they are needed to 
ensure the desired ZigZag Width can be selected.

7 Click the Background icon . The icon will 
change to the Fade Background icon  and the 
picture will be shown faded. Fading the picture 
display makes it easier to see the stitches over the 
background picture.
The picture will not be faded when it is printed out 
for stitching.

8 Click Zoom To Rectangle . The pointer will 
change to the zoom in pointer .

9 Click and drag around the top part of the doll, 
then lift the pen to zoom in.

10 Click the Free tab, and then click Free Motion .
11 Ensure the Free Motion Stitch Speed slider is in the middle of the slider bar.

If you prefer to draw more slowly, move the slider bar two or three steps to the left. You may adjust the Free 
Motion Stitch speed at any time.

There is a curved line across the dress that marks 
the waist. Start at the left end of this line, and draw 
stitches along the line to the right end of the line.
When stitching out, use this single line of stitching as 
a final check that the picture and embroidery aligned.

From the end of the line across the waist, 
trace over the outlines for the right sleeve. 
Follow the main outline of the sleeve to the 
top of the shoulder, but draw in and back to 
the main outline for the additional details.
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12 Click Zoom To Fit .
13 Set the ZigZag Width to 2.0mm.

If you previously reduced the Free Motion Stitch Speed, 
move the slider back to the middle.

14 Click Rotational ZigZag .
15 Trace over each of the dark pink semicircles. Move the pen (or mouse) at a steady medium speed, so 

that the zigzag stitch is open and evenly spaced.

If you wish to try again with a line of zigzag you have just drawn, right-click, then click Undo. Only the last 
line of zigzag will be undone. Then click Rotational ZigZag and draw the line again.

16 Right-click to deselect the function.

Decorate the Party Dress with Motifs
1 Click New  and in the Design Options page of the Load Design Wizard select Load Sketch 

Embroidery, then click Next. 
2 In the Load Embroidery page, click Open Embroidery and load Documents\Premier+2\Samples 

\Sketch\Stitch\PartyDressDoll_Free motion 1 done, then click Finish.
3 Click the Background icon  to set Fade Background  and the picture will be shown faded.
4 Click Pick Color . The pointer will change to the eyedropper .
5 Click the light green inside the swag (the decorative 

green band) and the Color Selection dialog box will 
appear. If needed, change the thread range to Sulky 
Rayon 40 and color1046 (Teal) will be selected. Click OK.

6 On the Standard tab, click Motif Line , then click the 
Options button. The Motif Line properties dialog box 
appears.

7 Ensure the Group is set to Universal. Click the drop-down 
arrow for Category and select Hand Stitches 2.

8 Click the drop-down arrow for Pattern and select the 
feather motif numbered 12.

Follow the main outline of the sleeve, back over the 
stitches you just placed, and return to the waist. 
Then trace over the folds in the bodice to travel to 
the left sleeve.

Trace the left sleeve, tracing over most 
areas twice, to return to the waist. Then 
trace along the line of the waist again, from 
left to right, drawing down and back along 
each of the gather lines of the skirt.
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9 Ensure Minimum Gap is set to 0.0mm, and that Fit to Line, Reverse and Mirror are all deselected.
10 Leave the Size, but ensure Stitch is set to Running. Click OK to close the Motif Line options dialog box.
11 Ensure Draw is set to Freehand .
12 Starting at the right side of the dress, draw along the center of the first small loop of swag until two 

motifs have appeared, then stop (lift the pen or release the mouse button).
Notice that the motifs only appear once you have drawn far enough to create a whole motif.

13 Continue to draw along the center of 
each loop of swag, and stop at the 
end of each loop. This prevents the 
motifs from overlapping too much at 
the top of each loop. The motifs may 
slightly overlap the semicircles.
Drawing motifs and other Standard 
stitches is not affected by the Free 
Motion Stitch Speed.

14 With Motif Line  still selected, click Options.
15 Click the drop-down arrow for Category and select General Motifs 1, then click the drop-down arrow 

for Pattern and select the motif numbered 3.
You may change motifs and motif settings while Motif Line is still selected.

16 Click the small down arrow on the Height box until the Height is reduced to 7.0mm.
The Width is changed at the same time, to keep the original shape of the motif, as selected by the 
Proportional option.

17 Change the Stitch type to Triple, then 
click OK.

18 Starting at the right side of the skirt, 
draw a row of motifs along the centre 
of the yellow band at the hem of the 
skirt. Draw the whole line, without 
stopping until the end.

19 Right-click to deselect motif line drawing.
20 Click Add Color Change  and the Color Selection dialog box appears. Click Show All Thread 

Ranges, then click the drop-down arrow for the Thread Range, scroll up the list and select Sulky 
Metallic 30. Select 7055 (Cranberry) and click OK.

21 Click Motif Line , then click Options.
22 In the Motif Line properties dialog box, set 

the motif Height to 8.0mm. Click OK.
23 Start a little to the left of the rose furthest 

to the left, then draw across the rose until a 
single motif appears, and stop.

24 Draw single motifs over the other two 
roses, in the same way.

25 Right-click to deselect the function. 
If you have drawn any motifs out of position, 
you can Undo  and draw them again.
To adjust the motifs later, use the Select functions. Click the Design tab, then hide all the colors except the 
metallic red. Click Box Select, then click and drag to draw a box around the desired motif. A selection box 
will appear. Move the motif over the rose, then right-click to deselect the function. Click Draw All Stitches.

Draw Free Motion Hair with Thread Blending
1 Click New  and in the Design Options page of the Load Design Wizard select Load Sketch 

Embroidery, then click Next. 
2 In the Load Embroidery page, click Open Embroidery and load Documents\Premier+2\Samples 

\Sketch\Stitch\PartyDressDoll_with_roses, then click Finish.
3 Click the Background icon  to set Fade Background .
4 Use the slider on the Zoom Bar to zoom in. 
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5 Then click and drag in the Overview window until the top part of the doll is shown.
6 Click Add Color Change  and the Color Selection dialog box appears. Click the drop-down arrow 

for the Thread Range and select Sulky Rayon 40. In Find Thread, enter the number 1238. Thread 1238 
(Orange Sunrise) is selected. Click OK.

7 Click the Free tab, and then click Free Motion .

Draw continuous lines. If you need to stop, start again from where you stopped.
8 Right-click to deselect Free Motion.
9 Click Add Color Change  and the Color Selection dialog box appears. Select Sulky Rayon 40, 1126 

(Tan), then click OK.
10 Draw hair on the left side and then the right side, using the same Free Motion  method. Use fewer 

lines and try to fill some of the gaps between lines of the previous color.
11 Finish in the hair curls on the right.

The blended colors give a more natural look to hair. Use similar techniques for fur and feathers.
12 Right-click to deselect the function.
13 Click the drop-down arrow next to the 

Background icon  and select Background 
On  to preview the result when the 
embroidery is stitched over the picture.

14 Click Zoom To Fit .
15 Click the Notes tab in the control panel and 

then click Edit.
16 In the Notes dialog add the text 'Motifs; 

Natural Hair'.
17 Click OK to save the changes to the notes.
18 Click the Settings tab, and then click Edit. You 

will notice that the Motifs are already shown. 
19 Motif settings are added for each line of motifs 

drawn. It is recommended to edit the settings 
to leave only one copy of the information for 
each motif used, and to remove other 
duplicate information.

20 Click OK to save the changes to the settings.
21 In the Quick Access toolbar, click Save  and save the embroidery as 'PartyDressDoll'.
22 Click Export  to export the doll embroidery.
23 In the Export dialog box, ensure that .vp4 is selected and click OK.
24 In the Save As dialog box, browse to Documents\Premier+2\My Designs, and save the embroidery as 

’PartyDressDoll Exported’ (a .vp4 file extension is added automatically).

On the left side of the hair, draw strands from the 
parting down to the curls, swirl around the curls 
and draw back up to the parting. Do this several 
times so that the left side is loosely filled.

Draw strands of hair on the right side, using 
the same method, and end at the parting.
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